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Product Status

The information in this document is Final, that is for a developed product.

Feedback
Arm welcomes feedback on this product and its documentation. To provide feedback on the
product, create a ticket on https:/support.developer.arm.com.

To provide feedback on the document, fill the following survey: https:/developer.arm.com/
documentation-feedback-survey.

Inclusive language commitment

Arm values inclusive communities. Arm recognizes that we and our industry have used language
that can be offensive. Arm strives to lead the industry and create change.

We believe that this document contains no offensive language. To report offensive language in this
document, email terms@arm.com.
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1. Introduction

1.1 Conventions

The following subsections describe conventions used in Arm documents.

Glossary

The Arm® Glossary is a list of terms used in Arm documentation, together with definitions for
those terms. The Arm Glossary does not contain terms that are industry standard unless the Arm
meaning differs from the generally accepted meaning.

See the Arm Glossary for more information: developer.arm.com/glossary.

Convention Use

italic Citations.

bold Terms in descriptive lists, where appropriate.

monospace Text that you can enter at the keyboard, such as commands, file and program names, and source code.

monospace underline

A permitted abbreviation for a command or option. You can enter the underlined text instead of the full
command or option name.

<and> Encloses replaceable terms for assembler syntax where they appear in code or code fragments.
For example:
MRC pl5, 0, <Rd>, <CRn>, <CRm>, <Opcode 2>
SMALL CAPITALS Terms that have specific technical meanings as defined in the Arm® Glossary. For example,

IMPLEMENTATION DEFINED, IMPLEMENTATION SPECIFIC, UNKNOWN, and UNPREDICTABLE.

Recommendations. Not following these recommendations might lead to system
failure or damage.

/N

Requirements for the system. Not following these requirements might result in
system failure or damage.

Warning
A Requirements for the system. Not following these requirements will result in system
failure or damage.
Danger
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An important piece of information that needs your attention.

A useful tip that might make it easier, better or faster to perform a task.

% A reminder of something important that relates to the information you are reading.

Remember

1.2 Other information

See the Arm® website for other relevant information.

e Arm® Developer.
e Arm® Documentation.
e Technical Support.

e Arm® Glossary.

1.3 Useful resources

This document contains information that is specific to this product. See the following resources for
other useful information.

Access to Arm documents depends on their confidentiality:

e Non-Confidential documents are available at developer.arm.com/documentation. Each
document link in the following tables goes to the online version of the document.

o Confidential documents are available to licensees only through the product package.

Arm tests its PDFs only in Adobe Acrobat and Acrobat Reader. Arm cannot
guarantee the quality of its documents when used with any other PDF reader.

Adobe PDF reader products can be downloaded at http:/www.adobe.com.
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2. Overview of Graphics Analyzer

Graphics Analyzer is a tool to help OpenGL ES and Vulkan developers get the best out of their
applications through analysis at the API level.

Graphics Analyzer is deprecated and will be removed in a future release.

The tool allows you to observe API call arguments and return values, and interact with a running
target application to investigate the effect of individual API calls. It highlights attempted misuse of
the API, and gives recommendations for improvements.

For help and support from Arm and fellow developers, visit the Arm Graphics and Gaming
Community.

2.1 Using Graphics Analyzer

Graphics Analyzer enables you to explore the graphical output of your Android application, and
identify scenes that might be causing performance problems. It captures every OpenGL ES or
Vulkan API call that your application makes as it runs on a target device.

Use Graphics Analyzer to evaluate the impact of each draw call and look for opportunities to
optimize performance, for example:

o To check that the level of detail is appropriate, look at the framebuffer output alongside object
geometry

e To check for pixels that are unnecessarily shaded multiple times, capture the level of overdraw
in a scene

e Find the most expensive shaders and where they are used in a scene.

e Check texture formats and the level of compression used.

To see Graphics Analyzer in action, watch this video.
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Figure 2-1: The Graphics Analyzer user interface

g

Examine API behavior

Graphics Analyzer shows you all the function calls the application makes as it runs on your
connected device. This information helps you to understand exactly what the application requested
from the graphics system and what the system returned. You can then investigate how and why
the system state changed over time.

At each function call, see the currently allocated buffer objects, shaders, and textures your
application is using, and their properties.

Graphics Analyzer reports problems such as improper use of the API. For example, passing illegal
arguments, or any issues that are known to adversely impact performance.

Figure 2-2: Trace Analysis view

0 Trace Anatysis £1 2 console Bochkmarks | | | Serigting

Message Count
Binding a buffer that was inftially bound to GL_ARRAY_BUFFER s not recomimended. 8072
U AP call retumed an emor code 10550
D 90.65% of the draw calis s using GL_TRIANGLES. 133400
Drarwr call indices buffer may be too sparse. (Total sparseness > 1.00]) 140

Framebuffer outputs

See the visual output to each framebuffer, alongside the color, depth, and stencil attachments. Step
through the draw calls to see how the frame is composed.
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Figure 2-3: Framebuffer view with color and depth attachments
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Geometry

Viewing the geometry alongside the framebuffer output helps you evaluate whether the level of

detail is appropriate for the object in the scene. Step through each draw call to see the impact on
the scene and whether you could improve performance by:

e Reducing the complexity of meshes.

e Using level of detail meshes for objects that are further away from the camera.
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Figure 2-4: Geometry view

dynr Benderts

Fragment count analysis

If a scene has too many fragments to process, or if fragments are too expensive to process
efficiently, you might see slow performance. In Graphics Analyzer, you can analyze the number of
fragments processed by each shader, alongside approximate cycle cost and register usage.

N

Figure 2-5: Fragment count analysis alongside shader program source
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Overdraw

If content has a high degree of overdraw it can perform poorly, because of the cumulative cost of
shading multiple layers. Poor performance can occur even if the layers are simple, especially for
devices running at high resolutions and frame rates. To show overdraw in Graphics Analyzer, areas
of the scene are overlaid with white, where multiple fragments are shaded per output pixel. The
whiter the area, the more overdraw is present.

Figure 2-6: Framebuffer view showing overdraw analysis
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Shader analysis

See which shaders are used in each part of the scene. The shader map helps you to detect
problems where incorrect shaders have been assigned. It also helps you find the most expensive
shaders that have the greatest impact on game performance. These shaders can be targeted for

optimization, either by reducing their complexity, or by reducing the number of fragments they
must process.

Figure 2-7: Framebuffer view showing shader map analysis
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Get started

Capturing data with Graphics Analyzer is easy. Your device must be in developer mode and have
USB debugging enabled. Graphics Analyzer connects to the device through USB, and captures your
application as it runs on the device. When you come to a problem area, pause Graphics Analyzer
and capture extra frame data, such as the framebuffer output, shader map, or level of overdraw.

See 4. Getting started on page 32 for full details.

2.2 Installation package

Graphics Analyzer is available from the Arm® Performance Studio product suite. The installation
package contains everything that you need to start investigating GPU applications.

The installation package contains three main components:
e The GUI application
e The target interceptor components

e Sample captures

After you have installed Graphics Analyzer, the extracted directory hierarchy on the host contains a
target directory with the following subdirectories:
android/arm/

Contains daemon and Graphics Analyzer interceptor for Android-based Arm®v7 (32-bit)
target devices.

android/armé4/
Contains daemon and Graphics Analyzer interceptor for Android-based Arm®v8 or later (64-
bit) target devices.

linux/arm_softfloat/
Contains daemon and Graphics Analyzer interceptor for Linux-based Arm®v7 or Arm®v8
(32-bit) target devices.

linux/arm_hardfloat/
Contains daemon and Graphics Analyzer interceptor for Linux-based Arm®v7 or Arm®v8
(32-bit) hard-float target devices.

linux/armé4_glibc/
Contains daemon and Graphics Analyzerinterceptor for Linux-based Arm®v8 or later (64-bit)
target devices that use the glibc C library.

linux/armé4_musl/

Contains daemon and Graphics Analyzer interceptor for Linux-based Arm®v8 or later (64-bit)
target devices that use the MUSL C library.
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3. Before you begin

Follow the steps in this section to prepare your applications ready to trace using Graphics Analyzer.

3.1 Host system requirements

Ensure that your host meets these requirements for running Graphics Analyzer:

e If you are capturing a Linux target, it can connect to the target using TCP/IP, for online analysis,
and has port 5002 open.

The default port is 5002. To change the default port, use the --port/-p option and
specify a different port number between 1 and 65535. See 4.3 Capture over TCP/IP
for Android and Linux devices on page 34 for more information.

e Atleast 8GB of system RAM is available. Arm recommends that you have at least 12GB of
RAM available.

3.1.1 Increase the available memory

To increase the maximum capture size that Graphics Analyzer can accommodate, increase the
amount of memory that is available to the application.

Procedure
1. Open <install directory>/gui/aga.ini with a text editor.

2. Find the Java Virtual Machine (JVM) argument starting with -xmx.
The number that follows the argument defines the maximum amount of memory that the
application claims when running, with a trailing m for megabytes or g for gigabytes.

3. Increase this number with a multiple of four that matches the capabilities of your system.
Ensure that your modifications follow the same format for the argument, that is no spaces and
a trailing lowercase m, or g.

3.1.2 Temporary storage

Depending on the complexity of the application being traced, Graphics Analyzer can require a large
amount of temporary disk storage.

By default, the system temporary storage directory is used. If there is not enough free space
available in this directory, Graphics Analyzer displays a warning and stops caching data to the
directory, increasing memory usage.
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Change the temporary storage directory by clicking Edit > Preferences and selecting an existing
directory for the Custom temporary storage directory field.

3.2 Target system requirements
Graphics Analyzer supports tracing on specific Khronos Group APls.

For Android:
e Vulkan 1.0-1.2 for Android 9 and above.
e OpenGL ES 2.0, 3.0, 3.1, or 3.2 for Android 8 and above.

A list of the recommended Android devices that support Arm® Performance Studio
is available from the Supported Devices page on Developer.

For platforms other than Android:
e Vulkan 1.0-1.2

e OpenGLES20,30,3.1,0r32
e OpenCL1.0,1.1,and 1.2

3.3 Android

Follow these instructions when preparing to capture an application on an Android target.

3.3.1 Prerequisites for Android targets

To run Graphics Analyzer on an Android target device, ensure that the host and target are
configured correctly.

Configure your host machine

e Install the Android Debug Bridge (ADB), which is available with the Android Software
Development Kit (SDK).

e Edit the paTa environment variable on the host machine to include the path to the Android SDK
platform tools directory.

Configure your device

e Connect your target device to a USB port on your host machine.

e Enable Developer Mode on the target device.

Copyright © 2020-2022, 2024 Arm Limited (or its affiliates). All rights reserved.
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o Enable USB debugging on the target device by selecting Settings > Developer options .

o For debuggable applications, follow the instructions in 3.3.2 Preparing to capture debuggable
applications on page 18.

e For non-debuggable applications, follow the instructions in 3.3.3 Preparing to capture non-
debuggable applications on page 18.

It is not possible to capture non-debuggable applications on release builds of
Android.

3.3.2 Preparing to capture debuggable applications

When all prerequisites are complete, the target device appears in the Device Manager in Graphics
Analyzer.

Before you begin
e The target device must be running a release build of Android 8.0 or above.

e Complete the prerequisites for Android targets.

Procedure

1. Open the Device Manager in Graphics Analyzer and find your device. See 4.2 Capture over
adb for Android devices on page 32 for more details.

2. If the Device Manager does not find your device, test the adb connection.
Connect the target device to your host machine, then run the adb devices command in a
terminal window. If the adb connection is good, you will see the ID of your device with no
permission errors, and you can run adb shell without issues. See the Android Studio User
Guide for more information.

3.3.3 Preparing to capture non-debuggable applications

To capture non-debuggable applications, you must install a Vulkan or OpenGL ES layer driver
and manually install and configure aga-daemon to collate information from different captured
applications. Then use the Device Manager to connect to your device.

Before you begin

e The target device must be running an eng or userdebug build of Android 10 or later. See https:/
source.android.com/setup/build/building for more information.

e Complete the prerequisites for Android targets.

About this task

e These instructions are only applicable to testing on pre-production devices running Android 10
or later.
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e These instructions do not require the application being profiled to be debuggable.

e Android virtualizes the file system, giving each user of an application a unique application data
directory named after their user ID. The default user, which is the most commonly used, is user
0. You can query the list of users configured on the device with the following adb command:

adb shell pm list users
Usersk:
UserInfo{0:Name String:cl3} running

The first number of the userinfo before :Name String is the numeric user_id which you can
use in the application directory path.

Procedure
1. Install the layer driver appropriate to the API you are using:
e To capture Vulkan applications using the Vulkan APl layers system, you must install the
interceptor as a global Vulkan layer on your device:
a. Copy 1ibvk layer aga.so onto the device:

o For 32-bit interceptor:

adb push target/android/arm/1ibVK layer aga.so /data/local/tmp
adb shell chmod 777 /data/local/tmp/libVK layer aga.so

o For 64-bit interceptor:

adb push target/android/armé64/1ibVK layer aga.so /data/local/tmp
adb shell chmod 777 /data/local/tmp/libVK layer aga.so

b. Open a shell on your target device as the super user by running:

adb shell
su

or

adb root
adb shell

c. Copy libVK_layer_aga.so into the app folder and rename it:

cp -f /data/local/tmp/libVK layer aga.so \
/data/user/<user id>/<package name>/libVkLayerAGA.so

d. Enable layers from the host machine:

adb shell settings put global enable gpu debug layers 1
adb shell settings put global gpu debug app <package name>
adb shell settings put global gpu debug layers VK LAYER ARM AGA

See Install Vulkan validation layers on Android for more information.
e o capture OpenGL ES applications, you must install the interceptor as a global OpenGL ES
layer on your device:
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a. Copy 1ibGLES layer aga.so onto the device then into the app folder:

adb push 1ibGLES layer aga.so /data/local/tmp
adb shell chmod 777 /data/local/tmp/libGLES layer aga.so
adb shell cp /data/local/tmp/libGLES layer aga.so /data/user/<user id>/
<package name>
b. Enable layers:

adb shell settings put global enable gpu debug layers 1
adb shell settings put global gpu debug app <package name>
adb shell settings put global gpu debug layers gles 1ibGLES layer aga.so

See Install OpenGL ES layers on Android for more information.
2. Open a shell on your host machine.
Navigate to the Graphics Analyzer installation directory.
4. Copy the daemon to your target device:

e [For 32-bit daemon:

w

adb push target/android/arm/aga-daemon /data/local/tmp

e For 64-bit daemon:

adb push target/android/arm64/aga-daemon /data/local/tmp

5. Open a shell on your target device as the super user by running:
adb shell
su
6. Install the daemon on the device, and grant appropriate permissions:
cp /data/local/tmp/aga-daemon /system/bin
chmod 777 /system/bin/aga-daemon
7. Enter the following commands on the host machine:

adb forward tcp:5002 tcp:5002
adb shell aga-daemon

Next steps

Open Graphics Analyzer and the Device Manager, then open the Linux/IP tab to connect to the
default IP address 127.0.0.1 and port 5002. See 4.2 Capture over adb for Android devices on page
32 for more information.

3.4 Linux

Follow these instructions for installing and using Graphics Analyzer on a Linux target.
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3.4.1 Prerequisites
To run Graphics Analyzer on a Linux target, ensure that the target has the following:

e A network connection to a host running the Graphics Analyzer GUI.

e The target must permit TCP/IP communication on port 5002.

To override the default port used for communication between the host
application and aga-daemon, Use the —-port/-p option to specify a different port
number between 1 and 65535. You must then open the Device Manager >
Linux/IP tab and enter the port number you are using.

3.4.2 Install Graphics Analyzer on a Linux target
To install Graphics Analyzer on a Linux target, take the following steps.

1. Navigate to the ./target/linux/ directory, and then to the appropriate directory for your
configuration.
Inside each of these directories, there are the following files:
® libinterceptor.so

® aga-daemon

¢ The Linux interceptor supports all Arm®v7 and later architecture-based
CPUs running Linux.

* Make sure that you use the correct libraries for your target architecture. If
you are running on Arm®v7, you must use either the soft float libraries or
the hard float libraries, depending on the requirements of your system.

e You can use the appropriate 64-bit build of the daemon when capturing
either 64-bit or 32-bit applications.

2. Install the daemon by copying aga-daemon to anywhere on your target device, and setting
the execute permission bit on the file. You can set the execute permission bit by running the
following command from inside the directory that you copied aga-daemon into:

chmod +x aga-daemon
3. Install the OpenGL ES, EGL, and OpenCL interceptor by copying libinterceptor.so to
anywhere on your target device.
4. Install the Vulkan layer:

a. Copy libinterceptor.so to anywhere on your target device, and rename it to
1ibVK layer aga.so.
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Graphics Analyzer supports capturing Vulkan applications on all Linux targets
except for Arm® soft-float.

b. <install directory>/target/linux contains the vk LAYER ARM AGA.json manifest file.
Copy this file into the same directory as 1ibvk layer aga.so.

If the application does not query or request them, loading layers and
extensions might be expensive and unnecessary. Manifests allow the Vulkan
loader to identify the names and attributes of layers and extensions without
needing to load them.

3.4.3 Connect the host and the target

To connect Graphics Analyzer on your host device to the target device you want to capture, the
daemon application must be running on the target device.

1. To start the daemon, open a terminal, navigate to the directory you copied aga-daemon into on
your target, and run:

. /aga-daemon

The daemon can handle multiple applications starting and stopping. Only close it when you
have finished capturing all the applications.

2. Connect to aga-daemon running on the device using the Device Manager. If the Device
Manager detects a running instance of aga-daemon on the local network, it gives you the option
to connect to it. Otherwise, you can use the Device Manager to directly connect to the IP
address of the device. See 4.3 Capture over TCP/IP for Android and Linux devices on page
34 for more information.

3. Start the application that you want to capture by following the instructions in 3.4.4 Capture an
OpenGL ES or OpenCL application on page 22, or in 3.4.5 Capture a Vulkan application on
page 23.

3.4.4 Capture an OpenGL ES or OpenCL application

To capture an OpenGL ES or OpenCL application, the system must preload the 1ibinterceptor.so
library that you copied onto your target.

To preload the library, define the Lo_preLOAD environment variable to point at this library. For
example:

LD _PRELOAD=/path/to/intercept/libinterceptor.so ./your app
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If you are unable to use Lo _PRELOAD ON your system, see /.1 Intercepting without using
LD _PRELOAD on page 84 for an alternative method.

If you have more than one version of your graphics driver on your system and are having issues,
see /.2 Multiple drivers installed on the system on page 84 for more information.

3.4.5 Capture a Vulkan application

To capture your Vulkan application, you must tell the Vulkan loader the location of the Graphics
Analyzer layer and manifest that you copied onto your target. You must also tell it the name of the
Graphics Analyzer layer to load as both an instance and a device layer.

For example:

VK_LAYER PATH=/path/to/aga/layer/ VK_INSTANCE LAYERS=VK_LAYER ARM AGA
VK_DEVICE LAYERS=VK_LAYER ARM AGA ./your vulkan app

The concept of device layers has been deprecated. However, some older drivers
might still require the vk_pEvICE 1LAYERS environment variable to be set to allow
Graphics Analyzer to trace all Vulkan function calls in the application.

3.4.6 Uninstall Graphics Analyzer

To uninstall Graphics Analyzer, remove the files that were copied onto the target platform.

3.5 Chrome OS

Follow these instructions for using Graphics Analyzer to capture an application running on a
Chrome OS device.

3.5.1 Prerequisites

Graphics Analyzer supports capturing the following types of application running on Chrome OS
devices:

e Android applications on Chrome OS devices that support the App Runtime for Chrome (ARC)
e Linux applications

e The Chrome application itself, and any Chrome apps that are running within Chrome OS

To debug your Chrome OS device, first enter Developer Mode. The next steps depend on the type
of application.
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To debug Chrome or Linux applications, enable debugging features when you boot
into Developer Mode.

3.5.2 Capture an Android application on Chrome OS

The App Runtime for Chrome (ARC) allows you to run Android applications on your Chrome
OS device. If your device supports the ARC, then you can capture your application in Graphics
Analyzer.

Capturing an Android application on Chrome OS is mostly the same as for other unrooted Android
devices:

1. Connect to your device over a network using adb. You can find the IP address of the target
device in the Chrome OS WiFi menu, and the default port to use is 22. For example:

adb connect (IP address) :22

For more information about connecting to a Chrome OS device over adb, see The development
environment.

2. To connect to the device and capture the application, follow the instructions in 4.2 Capture
over adb for Android devices on page 32.

3.5.3 Capture a Linux application on Chrome OS

Use the Linux interceptor and Graphics Analyzer daemon to capture a Linux application running on
a Chrome OS device.

You must set up SSH access to your Chrome OS device before you can capture
native Linux applications with Graphics Analyzer. For details, see Setting up SSH
Access to your test device.

1. SSHinto the Chrome OS device as root using the command:

ssh root@ (IP address)

2. Create a directory to store the Graphics Analyzer daemon and interceptor library, for example:
mkdir /usr/bin/aga

3. To allow connections on port 5002, run the following command:
sudo iptables -A INPUT -p tcp -m tcp —--dport 5002 -j ACCEPT

4. Copy the Graphics Analyzer daemon and interceptor library onto your device. Depending on
your device, use a version of the Linux Graphics Analyzer components appropriate to your
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architecture, either hard float, soft float, or 64-bit. You might need root access to copy files
onto the Chrome OS file system. For example:

scp libinterceptor.so root@ (IP address) :/usr/bin/aga/

From your root user SSH session, launch aga-daemon.

6. Using the Device Manager, connect to the running daemon by following the instructions in 4.3
Capture over TCP/IP for Android and Linux devices on page 34.

Launch a new SSH session.

Run your Linux application and preload the interceptor library by defining the Lo _preELOAD
environment variable to point at this library. For example:

LD PRELOAD=/path/to/intercept/libinterceptor.so ./your app

e If you are unable to use L.p_PRELOAD ON your system, see /.1 Intercepting
without using LD_PRELOAD on page 84 for an alternative method.

* |f you have more than one version of your graphics driver on your system
and are having issues, see /.2 Multiple drivers installed on the system on
page 84 for more information.

As a result, the capture data starts appearing in the desktop Graphics Analyzer client.

3.5.4 Capture the Chrome application on Chrome OS

Graphics Analyzer supports capturing Chrome applications in Chrome OS, which is useful for
debugging websites, web apps, and Chrome applications.

The method is similar to capturing a Linux application on Chrome OS, with a few differences.

You must set up SSH access to your Chrome OS device before you can capture
Chrome with Graphics Analyzer. For details, see Setting up SSH Access to your
test device.

Chrome QS ftries to reboot when you attempt to stop the Ul. To prevent this
reboot, you must modify the file /usr/share/cros/init/ui-post-stop by
commenting out the following lines:

while ! sudo -u chronos kill -9 -- -1 ; do
sleep .1
done

# Check for still-living chronos processes and log their status.
ps -u chronos --no-headers -o pid,stat,args |
logger -i -t "${JOB}-unkillable" -p crit

After you have SSH access and the ability to stop the Ul, install Graphics Analyzer on your device:
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1. Follow the Graphics Analyzer daemon and interceptor installation instructions in 3.5.3 Capture
a Linux application on Chrome OS on page 24.

2. Set up a password for the chronos user by starting an SSH session as root and using:

passwd chronos

3. Start a new SSH session, this time using the chronos user:

ssh chronos@ (IP address)

4. From your root user SSH session, launch aga-daemon. You might need to restart the root
session after starting an SSH session as chronos.

Connect to your Chrome OS device from Graphics Analyzer.

6. From your chronos SSH session, suspend the Chrome OS Ul using the command:

sudo stop ui

7. You must preload the interceptor library and launch Chrome from the chronos user SSH
session. For example:

LD PRELOAD=/usr/bin/aga/libinterceptor.so /opt/google/chrome/chrome \
--ozone-platform=gbm --ozone-use-surfaceless \
--user—-data-dir=/home/chronos/ —--bwsi \

--login-user="'Sguest' --login-profile=user

If you are unable to use b _PRELOAD ON your system, see /.1 Intercepting
without using LD_PRELOAD on page 84 for an alternative method.

As a result, capture data starts appearing in the desktop Graphics Analyzer client.

On some devices, Chrome might not launch correctly while the desktop Graphics
Analyzer client is connected, and might launch numerous subprocesses. If Chrome
does not launch correctly, disconnect the Graphics Analyzer client and launch
Chrome again. After it has launched, connect Graphics Analyzer and capture
Chrome.

3.6 webOS

Follow these instructions for installing and using Graphics Analyzer to capture different types of
webQS applications.
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3.6.1 Application support

Graphics Analyzer can capture all types of webOS applications, but different approaches are
required for each.

The application types are:

o \Web-based applications

e (QML-based applications

e Native applications

It is possible to capture one application type without capturing the others.

For each installed application, you can find the application type, internal name,
installation location, and main executable by examining the output from this
command:

luna-send -n 1 -f luna://com.webos.service.applicationManager/listApps
"{}ll

3.6.2 Install Graphics Analyzer on webOS

webQOS devices are based on Linux and can use Graphics Analyzer executables that are intended
for Linux.

Ensure that you use binaries that are compiled for the architecture of the target device, see 2.2
Installation package on page 15.

The installation steps are as follows:
1. Make a directory on the device named /opt/graphics analyzer/.
2. Copy the following files into this new directory:
e The Graphics Analyzer interceptor, 1ibinterceptor.so
e The Graphics Analyzer daemon process, aga-daemon
3. Create a script named /opt/graphics analyzer/aga-wrapper. |his script applies the Graphics

Analyzer interceptor to arbitrary applications. Populate the script as follows:

#!/bin/sh

MGD LIBRARY PATH=/usr/lib

LD PRELOAD=/usr/lib/libcbe.so:\
‘dirname $0°/ga/libinterceptor.so:\
$LD_PRELOAD

export MGD LIBRARY PATH LD PRELOAD
exec $0.bin "s$@"
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4. Create a script named /etc/init/graphics analyzer.conf. This script ensures that the

5.

Graphics Analyzer daemon launches at device boot. Populate the script as follows:

description "Launch the Graphics Analyzer daemon from Arm Ltd."

start on started sam

respawn

script

exec /opt/graphics analyzer/aga-daemon > /var/log/aga-daemon.log 2>&1
end script

This script directs messages from the Graphics Analyzer daemon to /var/log/
aga-daemon. log.

Edit the file /etc/luna-service2/1s-hubd.conf as follows:
e Llocate the [security] section.

e Change the Enabled key from true to false and save it.

This step allows you to change executables on the device without a security fault being issued.

3.6.3 Capture a web-based application

This method involves loading the Graphics Analyzer interceptor into the Web Application Manager
(WAM), which is the process responsible for displaying a web-based application.

The steps are as follows:

1.
2.

Open /etc/init/WebAppMgr.conf

Near the end of this file is a line beginning exec $wEBOS NICE $waM EXE PATH .. that loads
WAM. Immediately before this line, insert the following line to include the Graphics Analyzer
interceptor into the environment:

export LD PRELOAD=/usr/lib/libcbe.so:/opt/graphics analyzer/libinterceptor.so:
$LD_PRELOAD

Reboot or turn on the device.
Open the Graphics Analyzer host GUI application on your workstation.

Connect to the device using the Graphics Analyzer Device Manager. The device appears under
Linux Devices and can be chosen with a single click.

Start the web-based application.

The function calls are captured in the Graphics Analyzer host GUI. Other applications may be
captured at the same time, because many applications in webQOS are web-based.

Here and elsewhere, 1ibcbe.so (Google Chrome) must be placed in LD PRELOAD
before 1ibinterceptor.so. If you do not do this, web-based applications hang.
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For an example web-based application, see the app store, /mnt/otncabi/usr/palm/applications/

com.webos.app.discovery

3.6.4 Capture a QML application
/usr/bin/gqml-runner interprets QML applications.

Capture QML applications in the following way:

Navigate to /usr/bin/

Create the subdirectory /usr/bin/ga/, if it does not exist.

Hard link /opt/graphics analyzer/libinterceptor.so into subdirectory /usr/bin/ga/
Rename the executable /usr/bin/qml-runner tO /usr/bin/gml-runner.bin

Hard link /opt/graphics analyzer/aga-wrapper to /usr/bin/gml-runner

Reboot or turn on the device.

N AW e

Open the Graphics Analyzer GUI application on your workstation. Connect to the device using
the Graphics Analyzer Device Manager.

Start the QML application.

The function calls are captured in the Graphics Analyzer GUI application.

To temporarily disable the capture of QML applications, rename /usr/bin/ga/
libinterceptor.so, for example, tOo libinterceptor.so.removed.

For an example QML-based application, see the screensaver, com.webos.app.screensaver, under /

usr/palm/applications/com.webos.app.screensaver.

3.6.5 Capture a native application
The following steps show the general method of capturing a native application:

1. Run the following command:

luna-send -n 1 —-f luna://com.webos.service.applicationManager/listApps "{}"

Note the following information relating to the captured application:

folderPath
The home directory of the application

main
The main executable of the application. The following steps change this executable so
that the application loads the Graphics Analyzer interceptor.
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Move into the home directory of the application.

Make a subdirectory named ga. Hard link /opt/graphics analyzer/libinterceptor.so into
this subdirectory. Do not use soft links because some native apps execute in a chroot jail and
cannot see /opt/graphics_analyzer While running. As an alternative, copy libinterceptor.so
into this subdirectory.

4. Add an extension .bin to the main executable of the application.

w1

Hard link /opt/graphics analyzer/aga-wrapper into the home directory of the application,
giving aga-wrapper the same name that the main executable originally had. Alternatively, use a
copy rather than a hard link.

Open the Graphics Analyzer host GUI application on your workstation.
Connect to the device using the Graphics Analyzer Device Manager.

Start the application that you want to capture in the usual way.

0 o N O

The function calls are captured in the Graphics Analyzer Host GUI application.

To temporarily disable the capture, rename the hard link to 1ibinterceptor.so,
for example to 1ibinterceptor.so.removed. Note that this renaming affects other
native applications in the same directory.

Example 3-1: webOS main menu (com.webos . app . home)

This application draws the main system menu bar. The main executable of this application is /usz/
bin/com.webos.app.home. 10 capture this application, use the following commands:

mkdir -p /usr/bin/ga

1n /opt/graphics analyzer/libinterceptor.so /usr/bin/ga

mv /usr/bin/com.webos.app.home /usr/bin/com.webos.app.home.bin
1n /opt/graphics analyzer/aga-wrapper /usr/bin/com.webos.app.home

After the host GUI has started and is connected to the webQOS device, launch the main menu and
see the function calls being captured. To temporarily disable the capture, use this command:

mv /usr/bin/ga/libinterceptor.so /usr/bin/ga/libinterceptor.so.removed

3.7 Troubleshooting

This section describes how to avoid some issues that might prevent Graphics Analyzer working
correctly with your target.
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3.7.1 No capture is visible

The interceptor component on the target reports through 1ogcat on Android. If no capture is
found, then Arm recommends that you review the 1ogcat trace.

In general, ensure the following:

e On Linux, ensure that the interceptor library is in your pPrRELOAD path.

e Ensure you force close and reopen your application after installing the interceptor, to ensure
the interceptor is loaded.

e Ensure the daemon is started before the application.

e Ensure your application is making OpenGL ES or Vulkan calls.
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4. Getting started

This chapter describes how to use the host GUI to configure and capture framebuffer content. It
also describes how to use the capture modes in Graphics Analyzer to capture extra content.

4.1 Open Graphics Analyzer
Follow these instructions to open Graphics Analyzer.

e On Windows, click Start, expand the studio folder, then select Graphics Analyzer.

e On Linux, run the command:

<install directory>/gui/aga &

e On macQOs, press Cmd+Space, type Graphics Analyzer, then press Enter.

To load one of the supplied sample captures, select File > Open, or click the Open - icon, and
navigate to <install directory>/samples/traces/. Ihe various application windows fill with
information from the loaded capture which you can examine.

4.2 Capture over adb for Android devices

Connecting to your Android devices is automated through the Device Manager. The Device
Manager detects any Android devices that are connected to the host then automatically installs the
Graphics Analyzer components when the capture session starts.

Before you begin
Follow the instructions in 3.3.2 Preparing to capture debuggable applications on page 18.

About this task

Selecting an application using the Device Manager will only capture traces for user O in a multi-
user Android installation. To capture a trace for other users, see the instructions for 3.3.3 Preparing
to capture non-debuggable applications on page 18.

Procedure
1. Open Graphics Analyzer.

2. Click Open the Device Manager &
3. In the Android tab, choose which device you want to connect to.
4. Choose the application that you want to capture from the list of available options.
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Figure 4-1: Connect to your Android device in the Device Manager

£ Android | @ Linux / IP

Android Devices
Select the device you want to connect to, and then the package you want to instrument

©

Identifier Name Status

1A231FDF6002K6  Google Pixel 6 £ Disconnected

Packages Show only debuggable | Refresh &
Package Main Activity Debuggable
com.arm.malideveloper.openglessdk.metaballs Metaballs "4
com.arm.malideveloper.openglessdk.texturecube .TextureCube 1" 4
com.arm.vulkansdk.rotatingtexturefortest android.app.NativeActivity "4

API Selection

® @ Install OpenGL ES Interceptor
1' Install Vulkan Interceptor

Start Capture

5. Select the required API.

6. Click Start Capture.
Graphics Analyzer connects to your device and installs the layer driver and daemon application
that it uses to communicate with it. When the connection is established, the Device Manager
closes and the live capture is shown.

7. Optionally, select a preset configuration, or choose which API assets are captured.
Figure 4-2: Trace Config dialog

[ JTaceConfiglegacy | 4" # &* 13 10 -
Process Trace Configuration: -
Trace using a custom configuration.
OpenCL OpenGL ES Vulkan
D Program sources v Shader sources Shader binaries
Explicit memory v Shader uniforms Implicit memory
v Shader binaries
Texture contents
v Explicit buffers
v Implicit buffers
Output buffers

Apply the changes to update the trace configuration of the currently selected process.
SetasDefault  Apply Changes
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As you enable more asset types, the application runs slower, more memory is required, and
the generated capture file is larger. See 4.4 Configure tracing assets on page 37 for more
information.

8. Perform your test scenario on the device. Graphics Analyzer displays the data it receives from
the device.

9. When you see a problem area in the capture:

o Use the pause, step, and play buttons to locate a frame that you want to analyze more
closely. See 4.5 Pause, step frames, and resume on page 38.

o o capture the framebuffer output at the current frame, click the camera icon. See 4.6
Capturing framebuffer content on page 39.

o Capture extra frame data by enabling overdraw, shader map, or fragment count modes,
then click the camera icon to collect the data. Learn more about these modes in 5.
Analyzing your capture on page 42.

10. When you have captured the data you need, click Stop tracing 4
The frames are listed in the Trace Outline view. To identify the type of frame capture you
performed, an icon is shown next to the frames when you have captured extra data.

11. To show only the frames where you have captured extra data, select the Show Only Frames
With Features Enabled check box.

Figure 4-3: Show only frames with features enabled

0= Trace Outline $3 1 = 0

v/| Show Only Frames With Features Enabled =]

v Process 0 (com.arm.pa.paretrace) 628771135 vertices, 175129 drawe
» @@ Frame 0 4 vertices, 2 draws, 1instance, 0 instanced vertices, 4 ir
» @ Frame 564 1746525 vertices, 437 draws, 6460 instances, 1887
» K Frame 565 1763514 vertices, 439 draws, 6462 instances, 1887
» & Frame 566 1768260 vertices, 441 draws, 6465 instances, 1934
» (® Frame 567 1768260 vertices, 441 draws, 6465 instances, 1934

12. Expand a frame to see the render passes and draw calls within it. Select frames, renderpasses,
and draw calls to explore their data using the different data views. See 6. The Graphics
Analyzer interface on page 51 for more information about the views.

Next steps
To save or export the capture file, use the options under the File menu.

4.3 Capture over TCP/IP for Android and Linux devices

Connecting to a Linux device or IP address is automated through the Device Manager. The Device
Manager detects any Linux device on the network that has aga-daemon running on it. When a

Copyright © 2020-2022, 2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 34 of 85



Graphics Analyzer User Guide Document ID: 101545 0513 00 _en
Issue: 00
Getting started

connection is established, Graphics Analyzer installs the layer driver and daemon application that it
uses to communicate with it ready to capture your application.

Before you begin
To run Graphics Analyzer on a Linux device, ensure that the device has:

e Arunning OpenGL ES, OpenCL, or Vulkan application.
e A network connection to a host running the Graphics Analyzer GUI.

e The target must permit TCP/IP communication on port 5002.

Procedure
1. Open Graphics Analyzer.

2. Click Open the Device Manager &

3. Select the Linux/IP tab.
The Device Manager automatically shows any Linux devices on the same local network and
subnet as the host that are running the aga-daemon application. Alternatively, you can connect
to the IP address of the device.

4. Connect to your device using one of the following methods:

Figure 4-4: The Device Manager dialog

Android | & Linux / IP

Linux Devices L2
ldentifier Protocol GL Vendor GL Renderer GL Version

9;?) Start Ca... | mthikey (10.2.75.28) D026 ARM Mali-G71 OpenGL ES 3.2 notr...

Connect to an IP (7
Heost | 127.0.0.1 Port | 5002 ‘,#" Start Capture

e Select a Linux device. If no Linux devices have been detected, you can directly connect to
the device using the IP address instead.
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For Linux devices on IPv6 networks, automatic browsing of devices is not
supported. Connect to the device using the IP address.

o Enter the IP address of the device, and the port that the daemon is running on. Then click
Start Capture.

o |Pv4 and IPvé6 are supported. Devices that have both IPv4 and IPvé
addresses are accessible with either address.

o The default port is 5002. To change the default port, use the ——port/-p
option and specify a different port number between 1 and 65535. You
must then enter the new port number in the Device Manager > TCP/IP
tab

o The Device Manager obtains the GL Vendor, GL Renderer, and GL
Version strings of the device by dynamically loading the 1ibGLESV2
library. If this library could not be found or loaded, the strings appear as
Unknown.

Graphics Analyzer connects to your device and installs the layer driver and daemon application
that it uses to communicate with it. When the connection is established, the Device Manager
closes and the live capture is shown.

5. Optionally, select a preset configuration, or choose which API assets are captured.

Figure 4-5: Trace Config dialog

. TraceConfig:Legacy | 47 & &% 4 | -

Process Trace Configuration: b

Trace using a custom configuration.

OpenCL OpenGL ES Vulkan
( Program sources v Shader sources Shader binaries
Explicit memory v Shader uniforms Implicit memory
v/ Shader binaries
Texture contents

v Explicit buffers
v Implicit buffers
Output buffers

Apply the changes to update the trace configuration of the currently selected process.

Set as Default Apply Changes

The more asset types you enable, the slower the application runs, the more memory is required,
and the larger the generated capture file is. See 4.4 Configure tracing assets on page 37 for
more information.
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6. Perform your test scenario on the device. Graphics Analyzer displays the data it receives from
the device.

7. When you see a problem area in the capture:

o Use the pause, step, and play buttons to locate a frame that you want to analyze more
closely. See 4.5 Pause, step frames, and resume on page 38.

e Click the camera icon to capture the framebuffer output at the current frame. See 4.6
Capturing framebuffer content on page 39.

o Capture extra frame data by enabling Overdraw, Shader map or Fragment count modes,
then click the camera icon to collect the data. Learn more about these modes in 5.
Analyzing your capture on page 42.

8. When you have captured the data you need, click Stop tracing s
The frames are listed in the Trace Outline view. To identify the type of frame capture you
performed, an icon is shown next to the frames when you have captured extra data.

9. To show only the frames where you have captured extra data, select the Show Only Frames
With Features Enabled check box.

Figure 4-6: Show only frames with features enabled

O Trace Outline 3% 1 = 0

v'| Show Only Frames With Features Enabled | =

v Process 0 (com.amm.pa.paretrace) 688771135 vertices, 175129 draws
» &§ Frame 0 4 vertices, 2 draws, 1instance, O instanced vertices, 4 ir
» i Frame 564 1746525 vertices, 437 draws, 6460 instances, 1887
» K Frame 565 1763514 vertices, 439 draws, 6462 instances, 1887
» & Frame 566 1768260 vertices, 441 draws, 6465 instances, 1934
» (B Frame 567 1768260 vertices, 441 draws, 6465 instances, 1934

10. Expand a frame to see the render passes and draw calls within it. Select frames, renderpasses,
and draw calls to explore their data using the different data views. See 6. The Graphics
Analyzer interface on page 51 for more information about the views.

Next steps
To save or export the trace file, use the options under the File menu.

4.4 Configure tracing assets

When you have established a connection to a target device, configure which types of APl assets
are sent to the host when API function calls are captured.

For example, if you do not want to examine the contents of the textures and buffers being used in
your OpenGL ES application, use the Trace Config dialog to disable these asset types and speed up
capture of your application.
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The more types of assets you enable, the more information is visible in Graphics Analyzer.
However, the application being captured runs more slowly, the generated capture file is larger, and
Graphics Analyzer uses more memory.

Figure 4-7: Trace Config dialog

.+ Trace Config: Legacy F¥S 0 =+

Process Trace Configuration: -

Trace using a custom configuration.

OpenCL OpenGL ES Vulkan
(] Program sources v’ Shader sources Shader binaries
Explicit memory v Shader uniforms Implicit memory
v Shader binaries
Texture contents
v Explicit buffers
v Implicit buffers
Qutput buffers

Apply the changes to update the trace configuration of the currently selected process.

Set as Default Apply Changes

You can change the configuration at any time, even after the process has started. Any function calls
traced in the application after the new configuration has been set will use the new configuration.

If you are capturing multiple processes at the same time in the same capture, each process has its
own trace configuration. Changing the trace configuration of one process does not affect another.

Several configuration presets are available. You can also manually set a custom configuration. Any
configuration can be saved as the default, and is then used as the starting configuration for any
future connections to target devices.

Use the Legacy configuration to send assets that are equivalent to the default types
that were sent in versions of Graphics Analyzer before the Trace Config dialog
existed.

A distinction is made in the Trace Config dialog between explicit and implicit memory:

e Explicit memory is memory that a function call uploads explicitly. For example, in a call to
glBufferData, Or any other function call that explicitly specifies a host pointer and a length.

e Implicit memory is memory uploaded by modifying a buffer that has been mapped into the host
memory space. For example, in a call to glMapBuffer, vkMapMemory, Or any other function call
that returns a pointer to memory that the application can then modify.
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4.5 Pause, step frames, and resume

Graphics Analyzer displays the capture as data is received from the device. When you get to a
problem area, use the pause, step and play buttons to locate a frame that you want to analyze
more closely.

To pause the currently selected process, press the [l button. The process is stopped at the next
eglswapBuffers () call to allow you to examine the result. Pressing this button again before the
process has paused forces the application to pause on the next function call, regardless of whether
itis eglswapBuffers () Or not.

To pause all connected processes, press the & button. The processes are stopped at the next
eglswapBuffers () call to allow you to examine the result.

When a process is paused, you can render individual frames for the selected process by stepping
with the FI button.

To resume the selected process, press the # button.

Only the threads that are calling the graphics API functions are paused.

4.6 Capturing framebuffer content

To see the on-screen output sent to the framebuffer, capture frame data of the output from the
graphics system on a draw-by-draw basis.

Procedure
1. To take a snapshot of the framebuffer content following each draw call in the next full frame of
the application, click Capture .

Taking this snapshot involves considerable work in composing and transferring
data, which slows down the application.

2. Open the Trace Outline view. Any frames that include extra captured data are shown with an

icon, to identify the type of frame capture you performed. Any regular frame now has a @ icon
to show that it is a captured frame.
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Some limitations exist for frame capture of Vulkan applications. For more
information, see 6.10 Vulkan Frame Capture view on page 60.

3. Optionally, use the special capture modes to capture extra frame data, such as framebuffer
attachments, or to modify the framebuffer content. To enable a capture mode, toggle the

capture mode icon in the Graphics Analyzer toolbar, then click Capture 8 to trigger the frame
capture.

For example, to capture all available framebuffer attachments for each draw call, click #:. This
information is visible for each framebuffer in the Framebuffers view. For more information on
framebuffer attachments, see 4.6.1 Framebuffer attachments on page 40.

4 To stop tracing, click Stop tracing e

4.6.1 Framebuffer attachments

It is possible to capture most framebuffer attachments, including all color attachments and the
depth and stencil attachments.

In the following example, three squares are drawn on screen with varying depths moving from
-1.0 towards 0.0, with a colored cube rendered behind them. The draw calls for the four shapes
have different values set for the stencil buffer write mask, with the stencil pass operation set to
GL REPLACE.

Table 4-1: Example frame buffer attachments

Color attachment Depth attachment Stencil attachment

The color attachment shows which colors are rendered to the screen in that frame. It is the normal
screen output image that you get when you take a capture. To investigate a graphics rendering
problem, you can also capture other framebuffers.

The depth attachment helps you find rendering defects where fragments are being shaded in front
of or behind other fragments incorrectly. Depth values are stored with the color when a fragment
is shaded. Depth attachment values range from -1.0 to 1.0, where -1.0 is full blue, 0.0 is black, and

Copyright © 2020-2022, 2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 40 of 85



Graphics Analyzer User Guide Document ID: 101545 0513 00 _en
Issue: 00
Getting started

1.0 is full red. When subsequent fragments are drawn, the depth values are compared to determine
whether the new color is in front of or behind the one already drawn. If you get the depth values
wrong, then this view makes it easier to see what is happening. The output is enhanced on the host
to increase contrast.

The stencil attachment shows where you have used stencil values to control which fragments are
drawn. Stencil attachment values are from 0-255, where O is black, and 255 is red.

For information about capturing framebuffer attachments, see 4.6 Capturing framebuffer content
on page 39.

Limitations on capturing all framebuffer attachments

e |tis not possible to capture the depth or stencil attachments for FBO O on an OpenGL ES 2.0-
only configuration.

e Only a low-resolution capture of the depth buffer is possible when:
o The configuration does not support depth texture sampling.

o The device only has OpenGL ES 2.0 available and the depth attachment is a renderbuffer.
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5. Analyzing your capture

Learn about the different ways you can analyze your capture in more detail.

5.1 Analyzing overdraw

Overdraw occurs in graphics applications where scenes are built using multiple layers of objects
that overlap, and are rendered in a back-to-front order. High levels of overdraw can cause poor
performance on some devices, where pixels are unnecessarily shaded multiple times. Graphics
Analyzer shows the level of overdraw in a scene, to help you diagnose rendering order issues, and
find opportunities to optimize performance.

About this task

When Graphics Analyzer captures a frame with overdraw mode enabled, the fragment shader in
the target application is replaced with an almost transparent white fragment shader. Each time a
pixel is rendered to the framebuffer, the alpha value is increased using an additive blend. Therefore,
as more overdraw happens in an area, the whiter the final image appears.

Use overdraw mode to check that opaque objects are being rendered in a front-to-back order. This
order enables Arm® Mali™ GPUs to use early ZS testing to disable fragment shading for objects
that are hidden by objects that are closer to the camera, or by stencil masks.

If the scene uses transparency, some level of overdraw is expected, as objects must be rendered
back-to-front. Use transparency carefully in mobile applications, as the performance cost of shading
multiple layers can be significant.

Procedure

1. Connect Graphics Analyzer to the application on your device as described in Get Started with
Graphics Analyzer, and start your capture.

2. Perform your test scenario in the application on the device. To locate the right frame, just
before you get to the scene you want to analyze, use the pause and step buttons.

Figure 5-1: Pause and step buttons

F GO iR v > H

A

Step the currently selected application forward by one frame

3. Click the Toggle Overdraw Mode 2 icon to enable overdraw mode, then click the Capture @
icon to capture the next frame.

4. When you have captured the data you need, click the Stop tracing & icon.
The frames are listed in the Trace Outline view. Any frames where you have captured overdraw
are shown with the & icon.
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5. Expand a frame to see the renderpasses and draw calls within it. Step through the draw
calls and evaluate the framebuffer output to see how each drawn object affects the level of
overdraw in the scene. Hover over different areas of the scene to see the level of overdraw at

that point.
Figure 5-2: Levels of overdraw

'.'-}M.wﬂ.; Bendeitufirs T Frametutions I3 || 5 Bender Pans Dependencies | o) Textures - Shadens # Automated Trace

Actual Sire

Framebufer §
VER0 = 1080

¥ ARachments

GL_COLOR_ATTACHMENTO GL_DEPTH_ATTACHMENT HEsAagraT
GL_RGEAR, 1920 x 1080 GL_DEPTH_COMPOMNENT 24, 1920 1 1080 D

%
\‘ -_'f ,

6. View the histogram to see the number of pixels being shaded at each level of overdraw in the
scene.
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Figure 5-3: Number of shaded pixels
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When you have identified an area in the scene with high overdraw, refer to the following topics to
get advice on how to reduce it.

e For optimization advice for high overdraw on the Arm Developer website, see Optimization
advice for high overdraw.

» For blending advice in the Mali GPU best practises guide, see Blending advice for Mali GPUs.

5.2 Analyzing the shader map

Graphics Analyzer can give each shader program that a scene uses a different solid color.

During a live capture, click & to toggle the capture mode. While this capture mode is enabled,
when Graphics Analyzer captures a frame it tracks which shader each object in the scene uses. It
then maps each shader to a solid color. This mapping allows detection of any bugs that incorrect
shader assignment might cause. An example of this feature is displayed here:
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Figure 5-4: Original image

There are 100 unique colors that Graphics Analyzer can assign to shader programs, after which
programs have duplicate colors. You can identify which program corresponds to each color by
putting the cursor on a framebuffer image that was captured in shader map mode. The active
shader is identified above the image.

Any frame with shader map mode turned on has the Y icon in the Trace Outline view.
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5.3 Analyzing the fragment count

Graphics Analyzer can count the number of fragments that a shader processes per draw call. If
depth testing is enabled and a fragment would be excluded as a result, then that fragment is not
included in the count.

To toggle this feature, click ™. When a frame is captured while this capture mode is enabled, each
draw call increments the Fragments field of the fragment shader used to draw it. The fragment
count represents the number of fragments that have been rendered with the selected shader in the
current frame, up to and including the currently selected draw call. For example:

Figure 5-6: Fragment count analysis

Shader & UnkedProg.. Fragments Total Cycles  Percent Cycles Additional Information Cycles A us T Uniform Re... Work Regist.. Spilling Used

EERCZEEEEEEN

Total Cycles: 222780480 (cumulative over frame so far)
Only active shaders

Vertex | Fragmert | Compute | Geometry | Tessellstion Control | Tessellati

The Total cycles field is calculated using the average number of cycles for a given shader, multiplied
by the number of fragments processed.

The Fragments and Total cycles columns are only available for those frames where the fragment
count analysis has been requested. These columns indicate N/A (not available) for other frames.

Any frame with fragment count mode turned on has this ™ icon in the Trace Outline view.

e You cannot capture framebuffer content while also collecting fragment shader
statistics.

e Asingle draw call can take several seconds to complete. In addition, the target
device screen only shows the final draw call in a frame, and the frame capture
feature does not show any usable information.
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5.4 Debugging an OpenCL application

Graphics Analyzer supports the capture of OpenCL applications on Arm Linux, in addition to
OpenGL ES and Vulkan.

OpenCL capturing is a part of the interceptor library and does not require any special installation.
Because it is not a graphics API, there are a few things to bear in mind when debugging OpenCL
with Graphics Analyzer.

When you start or open an OpenCL capture, you are prompted to launch the OpenCL perspective.
This perspective adjusts the visible views to only those views that are supported for OpenCL. For
more information, see 6.1 Perspectives on page 51.

The Assets view tracks and displays contexts, kernels, memory objects, and programs. Graphics
Analyzer tracks the relationship between memory objects and subbuffers, which are displayed in
the Assets view. Graphics Analyzer warns you about dangerous overlapping subbuffers.

Graphics Analyzer tracks memory that is initialized into any memory object, using
the ct_MeEM Use HosT PTR flag. It also tracks calls to c1EnqueuecopyBuffer and
clEnqueueWriteBuffer. However, Graphics Analyzer does not support sending
changes to mapped OpenCL memory, or changes to memory caused by kernel
invocations. Therefore the memory reported in Graphics Analyzer might not
accurately reflect your application.

Because there are no conceptual frames in OpenCL, the Trace Outline assigns all function calls to
Frame O and Render Pass O. The Trace Outline view displays the following function calls:

1. Function calls that enqueue commands.
2. Function calls that block queued commands.

3. clFlush() and clFinish () function calls, which issue command queues to a device.

Blocking calls tell you how long they blocked for, and also the size of the wait list passed into the
function call, if applicable.

5.5 Using GPUVerify to validate OpenCL kernels

GPUVerify is a tool that can test whether an OpenCL kernel is free from various issues, including
intra-group data races, inter-group data races, and barrier divergence.

GPUVerify is a stand-alone application and is not provided by Graphics Analyzer. Download it

from the Imperial College website, GPU\Verify: a Verifier for GPU Kernels. Before using it with
Graphics Analyzer, Arm recommends that you get it working in a stand-alone context, using its own
documentation.
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To use GPUVerify with Graphics Analyzer, you must first point Graphics Analyzer to the binary
in your GPUVerify directory. Click Edit > Preferences and fill in the Path to GPUVerify field, as
shown here:

Figure 5-7: Preferences dialog

Preferences 2

“ @] Graphics Analyzer

-

Graphics Analyzer

[ Enable collection of anonymous usage statistics
General

Help Path to ADB Browse...
Perspectives Path ko GPUVerify Browse...
Custom temporary storage directory Browse...

Enable automatic perspective switching
@® Prompt ) Never () Always

[] Ignore missing license information
["] Don't warnwheninstalling root Android components
["] Don't warn when connecting to Android devices

["] Don't warnwhen Forcing Full Trace Replay configuration

Restore Defaults Apply
Cancel OK

If you enter an invalid path in this field, Apply and OK are grayed out.

When tracing an OpenCL application, Graphics Analyzer captures calls to all OpenCL 1.2 functions,
including clCreateProgramWithSource, clCreateKernel, clCreateKernelsInProgram, and
clEnqueueNDRangeKernel. It then uses the data from these functions to get:

e The names of all the OpenCL kernels.

e The source code associated with the OpenCL kernels.

e Any run-time parameters that are known at this point, for example the local and global
workgroup sizes.

To run any of the kernels that were found in a trace through GPUVerify, select a function call in the
trace with live kernel objects, then select Debug > Launch GPUVerify . You are presented with the
following dialog:
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Figure 5-8: Run kernel through GPUVerify dialog
I —

Run Kernel Through GPUVerify

All live kernel objects at the currently selected function call that have their full source code available are shown.

Kernel (ProgramiD::KernellD): | hello_world_opencl (0xb79000::0xdB5b00) = |

Local Work Size: 64 v
Global Work Size: 1000000 .

Kernel Build Options:

Cancel 0K

The Kernel drop-down list shows all the kernel objects that are live and have available source

code at the currently selected function call. Source code is only available to Graphics Analyzer for
kernels that have been created from a program that was created using clcreateProgramWithSource
followed by c1BuildProgram. If the kernel you expect to see is not in the list, ensure that you have
selected a function call where that kernel object is live and that the kernel was created using the
described method.

After you have selected a kernel from the drop-down list, the Local Work Size, Global Work

Size, and Kernel Build Options fields are populated with all the information Graphics Analyzer
has available. You can pick the local and global work sizes from the drop-down lists, which are
populated from the enqueue history of the kernel. Alternatively enter them manually as a comma-
separated list of numbers. The number of dimensions of the local and global sizes must match.

If invalid options are entered, an error box is displayed, giving more information. There are no
restrictions to the Kernel Build Options field, though GPUVerify might output an error if the
options are unsupported.

The output for GPUVerify is shown in the Graphics Analyzer Console view.

5.6 Comparing state between function calls

When investigating an application capture, you can generate a difference report to compare the
API state between two function calls to examine what has changed.

Procedure

1. To compare changes in state between two functions in the capture, use the Ctrl key (Windows
or Linux hosts) or Cmd key (OS X hosts) to either:

¢ In the Trace view, select two function calls.
¢ In the Trace Outline view, select two draw calls.

2. Right-click on the selected calls, then select Generate Diff from the popup menu.
The report shows the difference between states for the two selected function calls. It is a table
of the items that are different, or have changed at some point between the two functions.
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Figure 5-9: Difference Report view

Original value Current value Related functions
GL_CURRENT_PROGRAM 0 1 182, 170, 153
GL_ELEMENT_ARRAY _BUFFER_BINDING 0 0 89, 79, 63, 59
GL_VIEWPORT [0, 0, width, height] [0, 0, 2560, 1504] 180
GL_TEXTURE_BINDING_2D_ARRAY 0 0 326, 282, 276, 194, 107
GL_PIXEL_UNPACK_BUFFER_BINDING 0 0 278, 188, 119, 115, 111
GL_ACTIVE_TEXTURE GL_TEXTURED GL_TEXTURED 280
GL_COLOR_CLEAR_VALUE [0,0 0 0] [0.5 0.5, 0.5, 1.0] 172
GL_ARRAY_BUFFER_BINDING 0 0 87, 77, 55, 51
GL_UMIFORM_BUFFER_BINDING 0 0 322, 284, 71, 67
GL_CULL_FACE GL_FALSE GL_TRUE 178
GL_DEPTH_TEST GL_FALSE GL_TRUE 176
EGL_current_display <unknownz 0x74720ac8 46
EGL_current_read_surface <unknown=> 0x76%9ce8b8 46
EGL_current_context <unknown=> 0x75544fd8 46
EGL_current_draw_surface <unknown=> 0x76%9ce8b8 46

o Values that have changed but have since reverted to the original value are highlighted in
light blue.

o Values that are different between the two functions are highlighted in red.

e Where state values are made up of multiple components, for example cL_viewporT, the
subcomponents are highlighted individually. In this case, any subcomponents that have not
changed are shown with gray text.

3. The final column in the report, labeled Related functions, lists the numerical id of function calls
in the trace that modified the particular state item. Right-click on one of the rows, then select
Jump to related function and select a related function from the context menu.

4. To manually compare sets of changes, you can open multiple difference reports at a time. The
results of the state comparison are persistent until the window closes.

5.7 Bookmarks

Graphics Analyzer contains a Bookmarks feature to allow you to bookmark particular function calls
and optionally add notes to the bookmark.

These bookmarks can be saved and loaded with the capture. You can use this feature, for example,
to make notes on a function call that looks like it might be a candidate for optimization, as a
reminder.

Bookmarks can be viewed and manipulated in the 6.19 Bookmarks view on page 73 and the
6.2 Trace view on page 51.
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6. The Graphics Analyzer interface

This chapter describes the Graphics Analyzer host GUI which provides different views over the
application capture. The GUI also provides access to headless mode, which enables automated data
capture on the target.

6.1 Perspectives

Graphics Analyzer includes a perspectives feature which allows related windows to be grouped for
ease of use.

Graphics Analyzer comes with three perspectives:
* W OpenGL ES. This perspective is the default.
* T Vulkan

* OpenCL

These perspectives only have the views that are operational for the named API open by default.

Open new perspectives by selecting the B button. You can switch between perspectives at any
time using the perspective switcher that is at the top right.

By default, Graphics Analyzer prompts you to switch perspectives when it detects that the traced
process uses a different API to the currently selected perspective. This behavior can be changed

in Edit > Preferences > Graphics Analyzer to either never prompt you, or to always automatically
switch perspectives when a different API is detected.

Create custom perspectives by right-clicking on an existing perspective and selecting Save As ....
Custom perspectives can be removed using Edit > Preferences > Perspectives .

Customize perspectives by moving, resizing, opening, and closing views. Open views using the
Window > Show View menu. Customizations are saved when Graphics Analyzer is closed.

6.2 Trace view

The main window in Graphics Analyzer shows a table of function calls made by your application as
it is running. Use this information to examine what your application requested from the graphics
system and what the system returned.

Each call has:

e The time at which it was made.
e The time at which it finished.
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e The duration of the call in microseconds.

This duration is the time that is spent in the driver for the function call. It is not
how much time the GPU spends doing the work that the function call requests.

e The list of arguments sent to the call.

This list is truncated to save space. For a complete list of the arguments, see 6.5
Function Call view on page 56.

e The value, if any, returned by the underlying system when the function was called.
e The error code returned by the underlying system when the function was called.

e The process ID (PID) of the process the function call was made from.

e The thread ID (TID) of the thread the function call was made from.

e Any bookmark notes you have added to the function call. See 6.2.1 Add a bookmark to a
function call on page 53.

Some columns in this table might initially be hidden. To enable or disable columns,

. +
click .

Each call executed in a different EGL context is highlighted using a different color.

The Trace Outline shows a frame-oriented view of the trace. A call to eglswapBuffers () delimits
each frame. Draw calls in a frame are grouped by the framebuffer that is bound at the time they
were called. Selecting an item in the overview highlights the corresponding item in the main trace.

You can open documentation for an API call, if available, in a browser by menu-clicking on the call
and selecting Open Documentation.

It is possible to select two function calls from the trace using Ctrl+click on Windows or Linux hosts,
or Command-+click on OS X hosts. Menu-clicking on one of the two selected functions displays a
popup Mmenu showing various options including the ability to generate a state difference report, see
5.6 Comparing state between function calls on page 49. Alternatively, select two draw calls from
the Outline view and use the popup menu to compare the two draw calls instead.

Searching

To find a particular function call, or set of calls, Graphics Analyzer includes a search feature. You
can open the search dialog by pressing Ctrl+F with the Trace view selected, or by selecting Edit
> Find API call... from the main menu. Type your search string in the search box and Graphics

Analyzer highlights matching calls in the trace. Click 4 and T to jump between the search results.
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To close the search and hide the results, click # or press Esc.

By default, the search only looks at the function call name. If you want to search the function call
parameters as well, select the Include parameters option. With this option selected, Graphics
Analyzer searches the functions exactly as they appear in the Function Call column of this view.

See 6.21 Filtering and searching in Graphics Analyzer on page 75 for more information.

6.2.1 Add a bookmark to a function call

In the Trace view, the Bookmark Notes column lets you view and edit bookmarks for each function
call.

About this task

For general information on bookmarks, see 5.7/ Bookmarks on page 50.

Procedure

e To add a bookmark with a note, double-click on the Bookmark Notes column for the function
call and enter your note.

e To add an empty bookmark, right-click on the function call and select Add Bookmark.

Results

The bookmarked function call turns green in the trace and a green marker appears on the right-
hand side of the trace. The highlighting and markers allow quick navigation to bookmarked function
calls.

Figure 6-1: Bookmarked function call with a note

# Error Return Function Call Notes

92 GL_NO_ERROR glUniformli{location=2, vO=4)
& 93 GL_NO_ERROR glDrawElements(mode=GL_TRIANGLES, count=6, type=GL_UNSIGNED_SHORT, ind

94 GL_NO_ERROR glUniform li{location=2, vO=5) |-
& 95 GL_NO_ERROR glDrawElements(mode=GL_TRIANGLES, count=6, type=GL_UNSIGNED_SHORT, ind
| %5 EOLSUCCESS FGLTRUE cqSwapblffersUpy-Orl sufae-OGBa5d20)  Eorfame

You can disable the highlighting and markers by right-clicking anywhere in the Trace view window
and selecting Toggle Bookmark Highlighting.
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Figure 6-2: Toggling bookmark highlighting

Open Documentation

Copy Ctri+C

Export Textures

Export Shaders

Toggle Bookmark Highlighting
Add Bookmark

Remove Bookmark

View and manipulate all bookmarks in the 6.19 Bookmarks view on page 73.

To remove a bookmark, right-click on the function call and select Remove
Bookmark.

6.3 Trace Outline view

The Trace Outline view shows a summary tree view of the function calls made by your application
as it is running. Use this view to easily navigate through the trace.

The top-level items in the tree are processes. If you have traced more than one process on the
target system, you can switch between them by selecting them in this view. Selecting a process
causes the Trace view to only display calls for that process.

Function calls are further grouped depending on the APl in use. For example, OpenGL ES calls
are grouped into frames and render passes. For each item in the tree, including the groupings, the
name, index, and extra interesting information for that item are shown. For certain items, extra
information can be found in the tooltip for the item.

Selecting an item in the tree causes other views to be updated to provide information about that
item. Selections that are made in the Trace view, Breadcrumb bar, or the Statistics view Charts tab
cause the selection in the Trace Outline view to update. If the item selected in another view is not
an item in the Trace Outline view, a selection line indicates where the item would be.
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When you have a trace with many frames, you can use the Show Only Frames With Features
Enabled option to quickly find interesting frames. With this mode turned on, only frames that meet
one of the following criteria are shown:

e Frame Capture

e Fragment Count

e Overdraw Mode

e Shader Map Mode

To collapse all the items in the tree, click = Collapse All.

Right-clicking on items in the tree allows you to generate a diff report between two items and
export framebuffers. See 5.6 Comparing state between function calls on page 49 and 6.11.1
Exporting assets on page 63 for more information.

Each call that is executed in a different EGL context is highlighted using a different color.

6.4 Statistics view

Three tabs are available in this window, General, Charts, and Memory.

General

This tab gives statistics and averages for the currently selected process. Use this tab to gain
an overview of the state of your application as it ran.

Charts

This tab shows charts for various statistics for the currently selected item type. For example,
selecting a process shows you statistics about all the processes in the current trace. The
currently selected item is highlighted in the chart and the parent of the item is shown as the
chart title. The following actions are available for the charts:

e Hovering over a slice of the pie chart allows you to see more information about the slice,
including its value.

e Clicking a slice selects that item in the trace.

e Double-clicking a slice selects the first child of that item in the trace.

Some items do not support all the available statistics. For example, Render
Passes do not support the number of render passes statistic.

Memory

This tab shows information on memory usage for each frame. This data can be produced on
Arm® Mali™-T600 or later based devices, but the vendor might choose not to enable this
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feature. To see if this feature is supported, check if your device contains one of the following
files:

e /sys/kernel/debug/malilO/ctx/*/mem profile

e /sys/kernel/debug/mali/mem/*

If the files are present and non-empty, then your device is supported.

e To allow Graphics Analyzer to process this data, turn off the SELinux
permissions by running setenforce 0 on your device. If this command
produces an error, try the following command instead:

supolicy --live 'permissive untrusted app'

e You might need to mount the Linux debugfs mount point for this feature
to work, using:

mount -t debugfs /sys/kernel/debug /sys/kernel/debug

When selecting a frame, a pie chart showing the memory allocated by each channel is shown.
Each channel is a driver-defined heap for a different type of object:

e Hovering over a slice of the pie chart shows you the memory contained in that channel.

e Clicking a slice displays information about the memory contained in that trace and the
percentage of total memory used in that frame.

e Double-clicking a slice displays a histogram showing more details about the memory
allocations.

The histogram shows the number of memory allocations made for each memory range.
Hovering over each bar shows the total amount of memory this range contains.

6.5 Function Call view

This view has three sub tabs, Arguments, Additional Information, and Documentation. All the tabs
show data for the selected function call. Therefore, the data is visible only when a function call is
selected in the trace.

Arguments

This tab shows the unabridged arguments for the selected function call alongside their
values. This tab can be useful because, due to the limited size of the 6.2 Trace view on page
51, the values of arguments are truncated in that view to save space.

Additional Information

This tab shows any additional information that is available about the currently selected
function call. Only functions that are shown in the outline view have additional information.
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Depending on the type of function call selected, different information might be shown. This
view is useful when using indirect draw calls such as glbrawElementsIndirect. As those calls
use a command struct as a parameter, it is impossible to see what parameters were passed
to the call in the normal trace view. It simply shows the value of the struct pointer. However,
the struct is parsed and displayed in this view.

Documentation

This tab shows the Khronos documentation page for the selected function call, if it is
available.

6.6 Trace Analysis view

This view shows problems or interesting information related to API calls as they were made. These
problems can include improper use of the API, for example passing illegal arguments, or issues
known to adversely impact performance.

Use this view to improve the quality and performance of your application.

Selecting an entry in this view highlights the offending issues within the trace view. To gain a more
detailed view of the problem, if available, hover your cursor over the problem report.

6.7 Target State view

This view shows the state of the underlying system at a time following the function selected in
the Trace view. It updates as the trace selection changes. Use this view to explore how the system
state changes over time and the causes of that change.

This view is only available in the ' OpenGL ES + EGL perspective by default. For
more information, see 6.1 Perspectives on page 51.

The initial state is shown as an entry in normal type. If the relevant APl standard defines an initial
state, then this state is shown, otherwise <unknown> appears instead.

If a state item has been changed anywhere in the trace, it is highlighted in light green. A state item
that is not currently its default value is highlighted in dark green. Any read-only constant states
such as c1_mMax_praw_BUFFERS are highlighted in yellow. States that have never been changed in the
trace are shown in white.

If a state has been changed, you can find the function call that changed it by selecting Select
Previous Change Location from the right-click menu on the state item. The function call that next
changes a given state item can be located in a similar way.
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You can use the Filter box to filter the states and values in the view. For example, type texture into
the box and the view only shows states that have texture in the name or in the value. See 6.21
Filtering and searching in Graphics Analyzer on page 75 for more information.

In addition to the Filter box, there are several filtering modes available:
All states

No additional filtering is applied.
States that have been modified

Only show the states that have been changed in this trace.
States that have not been modified

Only states that never change value in the trace are shown.
States that are not currently their defaults

Only states that, at the currently selected function call, are not at their default values are
shown.

States changed by this function

Only states changed by the currently selected function call are shown.
Read-only states

Only read-only constant states such as ¢1._ Max DRaw BUFFERS are shown.

6.8 Buffers view

This view shows information about the currently allocated buffer objects.

You can filter the list of buffer objects by usage, or, for OpenGL ES only, by the last bound target
column. The bottom part of the view shows the size of the currently selected buffer objects. If no
buffer object is selected, the size of all the displayed buffer objects is shown.

To filter the view to show only the buffer objects with a given usage or last bound target, use the
Filter box. For example, type transform into the box and the view only shows you the buffer objects
that have transform in the usage field. See 6.21 Filtering and searching in Graphics Analyzer on
page 75 for more information.
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6.9 OpenGL ES Framebuffers view

After you have captured a frame using the Capture Frame button, you can find the results in the
Framebuffers view. Use this view to gain an insight into what the graphics system has produced as
a result of your application calls.

This view is only available in the ' OpenGL ES + EGL perspective by default.

See 4.6 Capturing framebuffer content on page 39 for more information about capturing frames.

Figure 6-3: Selecting a framebuffer in OpenGL ES Framebuffers view

@& Assets |'B Framebuffers 28 | [@ Textures| 1| Vertex Shaders ||/ Fragment Sh... ||z Compute Sha... | Frame overri...| = O

i B - pha

Framebuffer 9
512 x 512

Framebuffer 3

1920 x 1080

GL_COLOR_ATTACHMENTO GL_DEPTH_ATTACHMENT GL_STENCIL_ATTACHMENT

Framebuffer 1
1920 x 1080

Selecting a framebuffer in the left-hand list brings up a list of the attachments used in that
framebuffer in the lower list. If relevant, it also brings up histograms displaying the overdraw

or shader map data. To bring up a larger view of an attachment, select it in the lower list. For
multiview rendering, the views are displayed as separate selectable elements in the attachments
list. You can then mouse over the attachment for additional information. Double-clicking the main
image opens the attachment in an external editor.
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In certain situations, you might want to view the framebuffer with different alpha options. The
following alpha modes are available:
Use Alpha

Does normal alpha blending using the alpha values in the framebuffer.

Ignore Alpha

lgnores the alpha values in the framebuffer and sets the alpha value for each pixel to its
maximum, that is, fully opaque.

Visualize Alpha

lgnores the color information in the framebuffer and shows the alpha values for each pixel.
The alpha values are shown in a range from black (minimum alpha or fully transparent) to
white (maximum alpha or fully opaque).

For a captured frame, you can step through the sequence of draw calls one at a time and observe
how the final scene is constructed.

6.10 Vulkan Frame Capture view

You can capture framebuffers for Vulkan applications using the Capture Frame button. For all
calls to vkoueuesubmit within the captured frame, Graphics Analyzer captures each color, resolve,
and depth/stencil framebuffer attachment that has been modified by each draw call inside each
submitted command buffer.

This view is only available in the T Vulkan perspective by default.

See 4.6 Capturing framebuffer content on page 39 for more information about capturing frames.

Framebuffer attachment images that were created with anything other than the
VK_SAMPLE_COUNT 1 BIT as the samples parameter are not captured. However, if the multisampled
image has a corresponding resolve attachment in the render pass, the resolve attachment is
captured after each draw call.

The & Overdraw, & Shadermap, and ™ Fragment Count capture modes are unsupported for
Vulkan applications. These buttons are disabled when tracing an application that contains only
Vulkan function calls.

Also, the # Capture All Framebuffer Attachments button is disabled, because by default all
framebuffer attachments are captured.

When a call to vkoueuesubmit has been selected, the tree of draw calls within the vkoueuesubmit
is displayed in the Frame Capture view. Selecting any tree item shows information about that tree
item.
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Figure 6-4: Selecting a subpass in Vulkan Frame Capture view

L_Laﬁ.ssets @ Frame Capture 3 ®| Images P Automated Trace = B

v Render Pass 5
» Subpass 0
» Command Buffer 1
w Render Pass 0
» Subpass 0
v Render Pass 1
» Subpass 0
v Command Buffer 2
w Render Pass 0
» Subpass 0
v Render Pass 1
» Subpass 0
v Render Pass 2
» Subpass 0

Subpass 1
{

"o

"o

If the currently selected call to vkoueuesubmit is within a captured frame, selecting a draw call
displays the contents of all captured framebuffer attachments after that draw call was executed.

Figure 6-5: Selecting a draw call in Vulkan Frame Capture view

L&Assets @ Frame Capture g3 | [[E] Images # Automated Trace

B vkCmdUrawindexe
E vkcmdDrawindexs
E vkcmdorawindexe
E vkcmdDrawindexs
E vkcmdorawindexe
E vkcmdDrawindexs
E vkcmdDraw 3792¢
E vkcmdDrawindexe
E vkcmdorawindexe
E vkcmdDrawindexs
E vkcmdorawindexe
E vkcmdDrawindexs
E vkcmdorawindexe
» B Subpass 1
v B command Buffer 2
v B Render Pass 0
» B subpass 0
v B Render Pass 1
» B subpass 0
v B Render Pass 2
» B subpass 0
v B Render Pass 3
» B subpass 0
v B Render Pass 4
» B subpass 0
v B Render Pass 5
» B Subpass 0
v B Command Buffer 3
v B Render Pass 0
» B Subpass 0

Actual Size | Ignore Alpha -

Attachment 0 Attachment 1
D24 _UNORM_S8_UINT B10G11R11_UFLOAT_PACK32
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The =l icon is displayed next to tree items when framebuffer attachment data has been received.
You can view captured framebuffer attachments when the host receives the data. It is therefore not
necessary to wait until the Capturing frame dialog completes to start examining the data.

In certain situations, you might want to view the framebuffer attachment with different alpha
options. The following alpha modes are available:

Ignore Alpha

lgnores the alpha values in the attachment and sets the alpha value for each pixel to its
maximum, in other words, fully opaque.

Use Alpha
Does normal alpha blending using the alpha values in the attachment.

Visualize Alpha Channel

lgnores the color information in the attachment and shows the alpha values for each pixel.
The alpha values are shown in a range from black (minimum alpha or fully transparent) to
white (maximum alpha or fully opaque).

The stencil component of combined depth/stencil attachments is visualized in the alpha channel of
the displayed image.

High Dynamic Range (HDR) image formats such as vk_FORMAT B10G11R11_UFLOAT PACK32 are

tone mapped for display in the Ul. First the minimum and maximum floating-point values in the
entire image are calculated for each channel. Then the values for each channel are scaled to 0-255
according to these calculated minimum and maximum values. The tone mapper ignores channels
that have a value of O. These channels remain at O in the displayed image.

6.11 Assets view

The Assets view shows the tree of created assets and their properties at the currently selected
function call, for all supported APIs. Use this view to explore the API objects that your application
has created and is using.

In the tab pane on the right side of the Assets view, Source, Image, and Buffer tabs are available.
When certain assets, such as shaders, textures, or buffers, are selected, the appropriate tab that
can preview the content becomes selectable and displays the asset data.
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Figure 6-6: Assets view
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Under certain conditions, assets might be displayed differently in the assets view:

e Assets that are highlighted in green were created in the currently selected function call.

o Assets that are highlighted in light green were modified in the currently selected function call.
e Assets that are considered active, such as the currently bound OpenGL ES framebuffer, are

displayed in bold type.

The right-click context menu for assets allows you to navigate to the API call that created or
previously modified the asset.

6.11.1 Exporting assets
Assets can be exported from your application trace to disk.

You can export framebuffers in the following ways:

o Selecting File > Export All Captured Framebuffers . This option is only enabled if OpenGL ES
function calls are present in the application trace.
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e Selecting the frames, render targets, or draw calls containing the captured framebuffers that
you want to export from the Trace Outline view, right-clicking, and selecting Export Selected
Captured Framebuffers. This option is grayed out if your selection does not contain any
captured framebuffers.

You can export textures in the following ways:

e Right-clicking on a single function call and selecting Export Textures. This method exports all
textures that existed at the time of that function call.

e Selecting the textures that you want to export from the Textures view, right-clicking, and
selecting Export Textures.
You can export shaders in the following ways:

e Right-clicking on a single function call and selecting Export Shaders. This method exports all
shaders that existed at the time of that function call.

e Selecting the shaders that you want to export from the Shaders view, right-clicking, and
selecting Export Shaders.

6.12 Shaders view

This view is an alternative tabular view of all currently loaded shaders.

This view is only available in the '"® OpenGL ES + EGL perspective by default.

For each shader, various cycle counts are shown allowing you to identify which shaders are most
costly. These cycle counts are calculated using the Arm® Mali™ Offline Shader Compiler for the
Mali™-T880 GPU.

The Cycles field in the table shows the estimate of the number of cycles each shader takes for
a single invocation. This estimate might be inaccurate for any shaders that have any kind of
non-linear control flow. For example, a loop where the number of iterations cannot be statically
determined, or if the shader contains any if statements.

For fragment shaders, the Fragments column and other dependent columns are empty unless the
Fragment count feature was active for the selected frame. See 5.3 Analyzing the fragment count
on page 46 for more information.

Active shaders are shown in bold type.
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6.13 Textures view

This view shows an alternative tabular view of all currently loaded textures and includes
information on their size and format. Use this view to visualize the images that you have loaded
into the system.

This view is only available in the ' OpenGL ES + EGL perspective by default.

Loading textures is done using an external program.

For larger traces, the application can take a short time to convert and display all
textures.

The following texture formats are supported:

* GL_COMPRESSED RGBA8 ETC2 EAC

* GL COMPRESSED RGB8 ETC2

* GL ETCl RGBS OES

* GL_LUMINANCE

* GL_ALPHA

* GL_RGBA4

e GL RGBA With type GL UNSIGNED BYTE Or GL UNSIGNED SHORT 4 4 4 4
e GL RGB With type GL UNSIGNED BYTE

* GL COMPRESSED RGBA ASTC * KHR

* GL COMPRESSED SRGB8 ALPHA ASTC * KHR

In certain situations, you might want to view the textures with different alpha options. The
following alpha modes are available:
Use Alpha

Does normal alpha blending using the alpha values in the texture.

Ignore Alpha

lgnores the alpha values in the texture and sets the alpha value for each pixel to its maximum,
that is, fully opaque.

Visualize Alpha

lgnores the color information in the texture and shows the alpha values for each pixel. The
alpha values are shown in a range from black (minimum alpha or fully transparent) to white
(maximum alpha or fully opague).
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6.14 Images view

This view shows an alternative tabular view of all currently loaded images, including information on
their size and format. Use this view to visualize the images that you have loaded into the system.

This view is only available in the T Vulkan perspective by default.

Loading images is done using an external program.

For larger traces, the application can take a short time to convert and display all
images.

The following image formats are supported:
e VK FORMAT R8G8B8AS UNORM

e VK FORMAT R16G16B16A16 SFLOAT

e VK FORMAT R32G32B32A32 SFLOAT

* VK FORMAT R32G32B32A32 UINT

* VK FORMAT B8GS8RSAS UNORM

e VK FORMAT A2R10G10B10 UNORM PACK32
e VK FORMAT R32 SFLOAT

e VK FORMAT B10G10R11 UFLOAT PACK32

e VK FORMAT ASTC * UNORM BLOCK

e VK FORMAT ASTC_ * SRGB BLOCK

The view has the following limitations:
e Only one layer is displayed for multiple-layer images.
e Only base mipmap level is displayed.

e Optimal tiling images content is displayed tracking buffer-to-image and image-to-image copy
operations.

e Image copy operations from and to buffer subregions and from and to specific image
subresources are not supported.

In certain situations, you might want to view the images with different alpha options. The following
alpha modes are available:
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Use Alpha
Does normal alpha blending using the alpha values in the image.

Ignore Alpha
lgnores the alpha values in the image and sets the alpha value for each pixel to its maximum,
that is, fully opaque.

Visualize Alpha

lgnores the color information in the image and shows the alpha values for each pixel. The
alpha values are shown in a range from black (minimum alpha or fully transparent) to white
(maximum alpha or fully opaque).

6.15 Vertices view

This view has three sub tabs, Attributes, Indices, and Geometry. All the tabs show data for the
selected draw call. Therefore, the data is visible only when a draw call, such as glprawaArrays or
glDrawElements is selected in the trace.

This view is only available in the " OpenGL ES + EGL perspective by default.

6.15.1 Attributes tab
This tab shows the values of the vertex attributes that are passed to the vertex shader.

If GL_ELEMENT ARRAY BUFFER BINDING OF GI, ARRAY BUFFER BINDING iS set, the corresponding buffer
object is used to provide the values. The vertex indices used in this view have been sorted and
duplicates removed.

6.15.2 Indices tab

This tab shows the original list of vertex indices that were passed to the draw call.

6.15.3 Geometry tab
This tab shows, as a wireframe, the geometry drawn by the draw call.

This tab allows you to get a quick idea of what was drawn and also to inspect the geometry for
defects. You can see if the geometry is incorrect due to missing or unexpected extra vertices. Or
you can see if the geometry is too dense, which might lead to performance problems.
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If you use the Geometry view with the Framebuffers view, you can see where in the scene the
geometry was drawn. Seeing the position of the geometry allows you to detect if the geometry
is appropriate for its position in the scene. For example, if the geometry is always far away from
the camera, the geometry detail can be lower. Or, if the complex internal geometry of an object is
always occluded, it is probably not worth drawing.

To render the correct geometry, Graphics Analyzer must know which one of the shader attributes
corresponds to the geometry position data. You can select the attribute from the Position
Attribute choice box. Graphics Analyzer uses the names of the attributes and their types to initially
auto-select its best guess at a matching attribute.

The axes in the corner of the view show the orientation of the geometry relative to the three axes,
X (red), Y (green), and Z (blue).

The Geometry viewer and export function only work with the ¢1_TrRIANGLES,
GL_TRIANGLE STRIP, and ¢L_poinTs draw modes. When using c1_poInTs, each point
is rendered as a small tetrahedron. Primitive restart is also not supported. If you are
using this feature, you might see unexpected results.

Camera controls

You can rotate the camera around the center of the geometry by clicking and dragging the primary
mouse button in the view. For more precise rotation, the numeric keypad direction buttons 2, 4, 6,
and 8 can also be used to rotate the camera.

To zoom the camera in and out, use the mouse scroll wheel or the W and S keys.

To move the camera, click and drag with the secondary mouse button. Alternatively, to move left
and right press A and D, and to move up and down press Q and E.

To reset the position and orientation of the camera at any point, press the Reset Camera button.

Exporting

To do more in-depth analysis of the geometry, you can export it to a Wavefront .obj file. Most 3D
model editors and viewers can load these files. To export the geometry, right-click on the geometry
viewer and select Export to .obj.

o Wavefront .obj files do not support triangle strips so Graphics Analyzer converts
any triangle strip data to a series of individual triangles when exporting.

o  Wavefront .obj files do not support points so Graphics Analyzer converts any
point data into a series of small tetrahedrons when exporting.

Copyright © 2020-2022, 2024 Arm Limited (or its affiliates). All rights reserved.
Non-Confidential
Page 68 of 85



Graphics Analyzer User Guide Document ID: 101545 0513 00 _en
Issue: 00
The Graphics Analyzer interface

6.16 Uniforms view

This view shows uniform data for the active OpenGL ES shader program or programs, if program
pipeline objects are in use, at the time of the selected function call.

This view is only available in the ' OpenGL ES + EGL perspective by default.

For each active uniform, its index, location, type, and value are shown. If the uniform is a block, the
block name and the block buffer binding are shown.

6.17 Automated Trace view

The Automated Trace view allows you to run a range of standard Graphics Analyzer commands
automatically when a certain frame is encountered.

For example, you could run your application and automatically take a frame capture on frame 10,
do a frame capture with overdraw mode switched on at frame 20 and do a frame capture with
fragment count mode enabled at frame 30.

You can only add automated trace commands after an application has started.

To add an automated trace command, first select and pause the process that you want to add
commands to and then open the Automated Trace view:
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Figure 6-7: Automated Trace view

# Automated Trace & = d

& Add Command E3 Delete Command

Command Type Frame NMumber(s) &

Mo cantent in table

Select Add Command and the Add Automated Trace Command dialog opens:

Figure 6-8: Add Automated Trace Command dialog

Create a command to be run on a frame or frames.

Select a command type | Capture frame -

Frame number(s)

You must specify at least cne frame.

Cancel

Here you can select the type of command you want and which frames it applies to. You must
specify at least one frame number to add a command. For a frame number to be considered valid, it
must:

e Be greater than the current frame plus one.
e Not already have an automated command associated with it.

If the list of frames is invalid, the Frame number(s) text box is highlighted in red. A tooltip on the
text box gives the reason.
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Empty frame numbers, which are represented by a series of commas with no
numbers between them, and duplicate frame numbers are ignored.

When you have a valid list of frames, select the OK button:

Figure 6-9: Specifying a list of frame numbers

™ Add Automated Trace Command

Create a command to be run on a frame or frames.

Select a command type | Capture frame -

Frame number(s) | 12,13,14,15| |

Cancel | OK
You can then add more commands and remove existing ones:
Figure 6-10: Selecting command types
# Automated Trace & = d
’ & Add Command l E3 Delete Command
Command Type Frame Number(s) &
Capture frame 12
Capture frame with Overdraw mode enabled 13
Capture frame 14
Capture frame with Shadermap mode enabled 15

Disconnect from the current process before frame 16

When you are happy with the list, press the ® button. When the trace reaches frames that you
have added commands to, those commands are executed.
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If you send a play, step, or capture command in a frame, or in the frame before it,
automated trace commands for that frame are ignored.

6.18 Render Pass Dependencies view

Graphics Analyzer can work out what dependencies there are between different render passes in a
selected frame.

This view is only available in the " OpenGL ES + EGL perspective by default.

The different types of dependencies it can detect are:

e |f arender pass reads from a texture that was written to in a different render pass without
being cleared. For example, render pass O draws to texture 1 and render pass 1 then reads from
texture 1:

e |f arender pass has the same depth or stencil buffer bound as another render pass without
being cleared, assuming that depth or stencil testing is enabled. For example, both render pass
0 and render pass 1 have render buffer 1 attached to their depth target:

o If arender pass does a glelitFramebuffer call on a different framebuffer. For example, render
pass O draws to framebuffer 1 and render pass 1 blits framebuffer 1 into framebuffer 2:

The Render Pass Dependencies view shows render pass dependencies for the selected frame. To
generate a list of dependencies, select a frame in the Trace Outline view and press the Generate
button in the Render Pass Dependencies view. Any render pass in the selected frame that
depends on another render pass is shown in the tree. Expanding the render pass tells you:

e Which render pass it depends on.
e Which frame that render pass is in.

e Why Graphics Analyzer considers it a dependency.

The dependency analysis stops at the first dependency for each render pass. To find out the next
dependency in the chain, if there is one, select the frame with the earlier render pass in it and run
the analysis again.

For example, in the following screenshot, two of the render passes in Frame 1, namely Render Pass
1 and Render Pass 4, have dependencies on previous render passes. Render Pass 1 depends on
Render Pass 26 in the previous frame (Frame 0). Render Pass 4 depends on Render Pass 3 in the
current frame (Frame 1). In both cases, there are dependencies because Texture 18 is attached to
the active framebuffer for the render passes:
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Figure 6-11: Render Pass Dependencies view showing dependencies

so» Render Pass Dependencies 52 = g

Generate

¥ Render Pass 1

Depends on Render Pass 26 in Frame 0 due to Texture 18
¥ Render Pass 4
Depends on Render Pass 3 in Frame 1 due to Texture 18

6.19 Bookmarks view

This view shows bookmarks that have been added to the trace and allows you to add, remove, and
edit bookmarks.

Bookmarks are links to specific function calls in the trace and can contain notes for you to add
interesting information. Pressing the "o Add Bookmark button adds an empty bookmark to the

currently selected function call in the Trace view. Pressing the “@ Remove Bookmark button
removes the selected bookmark from the Bookmarks view. You can edit a bookmark by double-
clicking on the notes area next to the bookmark.

For more information, see 5.7 Bookmarks on page 50.
Bookmarks can also be viewed and manipulated in the Trace view.

You can jump to the function call associated with a bookmark by clicking the Go to Function
button next to the bookmark.

6.20 Scripting view

The user interface might not have all the tools that you require to extract or analyze information
that is retrieved from the target device. Therefore Graphics Analyzer has a Python scripting
environment that allows you to directly interface with the Graphics Analyzer trace model. You can
either perform an analysis natively in Python, or output the data that you need to an external file.

The Jython interpreter

The Scripting view contains a Jython interpreter that implements the Python 2.7.0 specification.
The interpreter supports the standard Python syntax and the Python standard library.

There is one interpreter per trace file. These interpreters cannot share data. Closing the Scripting
view closes all interpreters. The interpreter supports loading script code in the following forms:
e User script files that you load and run from the Scripting view.
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e Python modules that you load using the import statement in a user script. Imported user
modules are found by searching based on the JYTHON_PATH environment variable, not the
PYTHON_PATH environment variable.

After a script completes, all globally scoped declarations (imports, global variables,
class definitions, function definitions, ...) persist in the scripting environment.

For convenience, the interpreter is initialized with two extra global variables:
trace
A representation of the Graphics Analyzer internal model.

monitor

An interface to the progress bar underneath the interpreter input text area. You can use this
interface to track progress in your scripts.

For more information about these objects, or any other Graphics Analyzer object, use the built-in
Python help function to print APl documentation. For example:

help (trace)

Graphics Analyzer also comes with some sample scripts in <install directory>/samples/
scripts/ that provide examples of different ways to perform analysis on a trace object.

The scripting console
The scripting console allows you to interact with the Jython interpreter.

You can use the Up and Down keys to move through a history of the commands you have
previously executed.

Clicking Interrupt & causes any running script and any created threads to stop.
Clear % allows you to clear the output text area.

To reset the interpreter back to its original state, click Reset

Loading scripts

The Scripting view contains an interactive interpreter, but for more complicated analysis it is easier
to write a script in a separate Python file. The Scripting view also allows you to load Python scripts,
or directories of Python scripts, from your file system. Graphics Analyzer only loads scripting files
with the .py extension.

The script locations that you load are stored in your workspace and are persistent across runs of
Graphics Analyzer.
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To load a single script, click Add Script L.

To load a directory, click Add Directory d. File-system changes to this directory are reflected in
Graphics Analyzer.

To remove any top-level item, click Remove @ The file and directory on the file system are not
affected.

Scripts are loaded and displayed in a staging area next to the interpreter. To execute a script, either
double-click it or highlight it in the staging area and either right-click and select Run or press the R
key.

Performance considerations

The scripting environment is powerful, but also potentially memory intensive. The following tips
might help improve the performance of your scripts:

e Holding global references to objects that you no longer need wastes memory. Delete
an individual reference with the de1 keyword or click Reset to re-initialize the scripting
environment, deleting all references.

e Only touching the parts of the model that you are interested in keeps memory usage low.
o Traversing the model forwards is faster than traversing backwards.

e Printing excessively large strings to the interpreter console can slow down the Graphics
Analyzer user interface. If you must write large strings, write to an external file rather than the
scripting console.

6.21 Filtering and searching in Graphics Analyzer

Filtering and searching in Graphics Analyzer uses Java regular expressions. For example, type
gl program|gl texture into a filter or search box to match entries that contain g1_texture or
gl _program. Filtering and searching in Graphics Analyzer is case insensitive.

By default, matches are performed on substrings. For example, program matches ¢1_procram. To
anchor your expressions, use the standard regular expression boundary matchers such as ~ for the
beginning of a line, and s for the end of a line. For example, programs matches GL_CURRENT PROGRAM
but not G PROGRAM PIPELINE BINDING.

If the filter you type is not a valid regular expression, the Filter or Search box goes red and the
error is shown as a tooltip.

To learn more about Java regular expressions, see:

e (Class Pattern

e Oracle regular expressions tutorial
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6.22 Host-side headless mode

Headless mode allows you to do certain tasks without launching the Graphics Analyzer user
interface. It allows you to automate tracing a target device, or export assets from an existing trace.

You can also use headless mode to trace a target device using just the target-side components.
The main difference between using the host and target-side headless modes is where the trace
output is stored. Host-side headless mode can only save traces to the host machine, and target-
side headless mode can only save traces onto the target device. The interfaces for each headless
mode are also slightly different. For more information, see 6.23 Target-side headless mode on page
78.

Exporting assets from an existing trace file can only be performed on the host.

6.22.1 Exporting assets

You can use headless mode to export shader source code and texture assets from an OpenGL ES
trace. You must provide an index in the trace from which to export.

For example, you could export the shaders that were loaded at the end of frame 15, or the textures
that were loaded at function call index 500.

To export assets, run the aga-headless script from the Graphics Analyzer installation directory.
Pass in the location of the trace file to export assets from. You must also provide the output
directory with the ——export-output-directory switch. This directory is used to write the exported
shaders and source code, and must be writable, otherwise the export operations fail.

You must provide the name of the process that you want to export assets from with the -p or
--process switch. If your trace contains multiple processes with the same name, you must also
provide the process ID of the process you want to export from, using the —-process-id switch.

Provide the trace index for Graphics Analyzer to extract the assets from. Graphics Analyzer
attempts to compute the OpenGL ES state at the index and export the assets that are present at
that point.

You can specify the index as a function call by using these switches:

-—-export-function-textures
—--export-function-shaders

Alternatively, you can index the trace by the frame number, which works the same way as selecting
a frame in the Trace Outline. Graphics Analyzer indexes the trace to the function call at the end of
the frame that you provide.
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You can specify the index as a frame by using these switches:

—--export-frame-textures
—-—export-frame-shaders

You can specify a trace index only, in which case Graphics Analyzer exports all assets of the
specified type at that index. For example, --export-frame-shaders 15 would export all shaders
from frame 15.

You can further provide a comma-separated list of asset IDs to export from the trace index, in
which case Graphics Analyzer exports those assets only. Join the frame index to the list of asset
IDs with a colon (;) character. For example, -—export-function-textures 100:1,2,3,4 would
export only texture IDs 1, 2, 3, and 4 from function call index 100.

You can specify multiple frame indexes in the same command. Each index requires its own switch.

Putting it all together, the final command looks similar to this example, using Unix formatting
convention:

aga-headless/path/to/trace.mgd --export-output-directory /path/to/output-dir \
-—-process com.my.process —--process—-id 3089 --export-frame-textures 22 \
--export-function-shaders 200:1,2,3,4,5

This command exports the textures from frame 22 and the first five shaders from function index
200 into the output-dir directory.

6.22.2 Tracing a target device

You can use headless mode to trace a target device with the same configuration options that can
be enabled from the GUI.

To get a full list of all the command-line switches, invoke the headless script with
missing or malformed arguments. For example, invoking aga-headless with no
arguments causes the command line to fail and triggers the headless mode help
to print to the console. This help message contains an explanation of each of the
command-line switches, which map to functionality from the GUI. If it is your first
time running headless mode, or if you need reminding how to configure the trace,
use this method to get the headless mode documentation.

Headless mode assumes that the Graphics Analyzer daemon is already installed on the target
device. Instructions are available in 3. Before you begin on page 16.

Graphics Analyzer requires you to provide details about the device to connect. Use an IP address to
connect using the --device-ip switch. Make sure that the aga-daemon executable is running on the
target. Graphics Analyzer attempts to connect using port 5002.
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You must specify a process name with --process. Headless mode does not support tracing multiple
processes.

You must provide a file name with --trace-file-output. This file is where the trace is written to
when the session ends. You must provide a file path that points to a writable location and include
the file name you want to use, for example /path/to/my-trace.mgd. Use the .mgd extension so
that Graphics Analyzer recognizes it as a trace file. If you do not use the standard extension, it is
appended to the file name automatically.

If the file you provide exists, Graphics Analyzer tries to delete it when it saves the
trace.

To tell Graphics Analyzer when to stop tracing, use --timeout to set a timeout in seconds, or --
exit-at-frame to set a frame limit for the trace.

You can also use the command line to set the trace configuration. Use the preset configurations,
such as Full Trace, using the --trace-config switch. Alternatively, you can manually tell the
interceptor to collect specific data, depending on your needs. For the full list of switches and valid
inputs, run headless without any arguments to generate the help message.

6.23 Target-side headless mode

Headless mode allows you to perform a trace on the target device without a connection to the
host Graphics Analyzer application. In target-side headless mode, trace files are stored in a local
directory on the target device.

There are two ways to use headless trace mode:
e Using a global configuration file

e Using the daemon in headless mode

You can also use headless mode to trace a target device from the host machine, without using the
host GUI. The main difference between using the host and target-side headless modes is where the
trace output is stored. The host headless mode can only save traces to the host machine, and the
target headless mode can only save traces onto the target device. The interfaces for each headless
mode are also slightly different. For more information, see 6.22 Host-side headless mode on page
75.

Exporting assets from an existing trace file can only be performed on the host.
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To run target side headless mode on a Linux target, you must load the interceptor before the
application starts. Either use L.p_prRELOAD, see 3.4.4 Capture an OpenGL ES or OpenCL application
on page 22, or to load without Lp_prReLOAD, see /.1 Intercepting without using LD_PRELOAD on
page 84.

6.23.1 File locations

The locations for the configuration file and the output trace file on the target device depend on the
target OS.

Android

By default, trace files are saved to the sEXTERNAL STORAGE/traces/ directory if the application
loading the interceptor has the Android wRITE EXTERNAL STORAGE PErmission, or /data/user/
<user id>/<package name> if the permission is not available.

Place the default configuration file in $EXTERNAL STORAGE/aga-headless.conf if the application
loading the interceptor library has the Android READ EXTERNAL STORAGE PErmission, or /data/user/
<user id>/<package name>/aga-headless.conf if not.

e |f the target device is non-rooted, make sure that the application manifest
contains the wRITE EXTERNAL STORAGE permission and that the application has
that permission enabled in Settings. Without this permission, it is not possible
to set the configuration file for the application or write the trace files, as internal
application storage cannot be accessed without su, which requires the device to
be rooted.

e Android devices might implement specific SELinux policies which prevent
Graphics Analyzer from reading the headless mode configuration file. You
can verify if these policies are implemented by checking if there are any error
messages using adb logcat -s audit. You can solve the issue by disabling
SELinux on your rooted device.

e The wRITE EXTERNAL STORAGE permission also implicitly grants
READ EXTERNAL STORAGE, SO if this permission is available, the interceptor always
looks for the config file in SEXTERNAL, STORAGE/aga-headless.conf.

e On most devices $EXTERNAL STORAGE iS /sdcard.

Linux
Trace files are saved to the snomE/traces/ directory by default.

Place the configuration file in $HOME/aga-headless.conf.
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The headless configuration file is formatted as JSON. The top-level object contains a single key,
processes, Which is an array of JSON objects, with each object corresponding to a configuration
for an individual process.

Configuration file items are case-sensitive. Make sure that keys and values are typed
exactly as shown.

Table 6-1: Configuration file keys reference

Key Type Accepted values Description
name String | A valid process name, or package name on Android. Name of the process. This key
is required.
config String |fullTrace, everything, balanced, functionsOnly, Preset config name.
legacy. Default = legacy.
customConfig Object |A valid customConfig object, see 6.23.2.1 Custom config Custom configuration of
reference on page 80. You can use the preset as-is with no resources per API.
changes.
traceDirectory String | A valid filesystem path. See 6.23.1 File locations on page 79. Directory used for creating
headless trace files.
frameCaptures Object |A valid frameCaptures object. See 6.23.2.2 Frame captures Allows setting frame captures
reference on page 81. frame numbers and modes.
disconnectBeforeFrame |Integer | A valid frame number. Number of the frame to
disconnect and disable tracing
before.

6.23.2.1 Custom config reference

The customconfig object contains keys for each API. Values are objects containing Boolean keys

specifying whether resources are enabled for that API. All keys are optional.

For an example of how to format this object, see 6.23.2.3 Example configuration file on page

81.

Custom configuration resource toggles are always applied after the preset. A preset
can therefore be applied first and then modified by applying the changes made

by the custom preset on top. For example, after applying the Everything preset
and a custom config with gles.shadersources disabled, the resulting config has all
resources except OpenGL ES shader sources enabled.

customConfig object keys

cl
gles

OpenCL config object.
OpenGL ES config object.
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vulkan Vulkan config object.

OpenCL config object keys
® programSources

® explicitMemory

OpenGL ES config object keys
® shaderSources

® shaderUniforms

® shaderBinaries

® textureContents

e explicitBuffers

e implicitBuffers

e outputBuffers

Vulkan config object keys
® shaderBinaries

e implicitMemory

6.23.2.2 Frame captures reference
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The framecaptures configuration object contains keys for each frame capture mode. All keys are

optional.

The framecaptures object keys are:
e default

® overdraw

e fragmentCount

e shaderMap

e allAttachments

All these keys are integer arrays.

For an example of how to format this object, see 6.23.2.3 Example configuration file on page

81.
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6.23.2.3 Example configuration file

This topic shows an example of a headless configuration file.

6.23.3 Starting the daemon in headless mode

As an alternative to using a headless configuration file, you can start the daemon in headless mode
by passing arguments to it.

A limitation of using the daemon arguments instead of a headless configuration file
is that only one process, specified using --name, can be configured at a time. The
Note configuration file can contain multiple configurations for different processes.
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The daemon accepts a series of arguments. For details, see 6.23.4 Arguments accepted by the
daemon on page 83. If the --HeadlessMode argument is present, the daemon starts in headless
mode. Otherwise, it starts as normal, ignoring the rest of the headless configuration arguments.
The daemon does not reset the headless mode configuration until you kill the daemon or you
connect to the host.

The process for starting the daemon in headless mode depends on the target device. However, the
argument names are the same for both methods.

For a Linux device, start the daemon executable, passing extra arguments as required. For example:

./aga-daemon --HeadlessMode --name cube

To stop the daemon, kill it like any other Linux process. Killing the daemon clears any headless
configurations that were passed in as an argument.

6.23.4 Arguments accepted by the daemon

You can pass these arguments to the daemon when starting it in headless mode.

e |f —-HeadlessMode is specified, --name must also be specified, otherwise the
daemon does not start.

e For explicit resource arguments, specified as 1 or O, if the argument is not
present, the resource setting from the preset is used.

o Comma-separated argument values have the format 1,[2...] with no spaces. For
example, 1,2,4,8.

Table 6-2: Arguments accepted by the daemon in headless mode

Argument Description

--HeadlessMode Start the daemon in headless mode. Default = false

--name/-n {process_name} Name of the process. If ——HeadlessMode is present, this argument is required.

--config/-c {preset name} Config preset. See accepted values for the config key in 6.23.2 Headless
configuration file reference on page 79. Default = 1legacy

-—traceDirectory/-o {directory} Output directory for trace files. See 6.23.1 File locations on page 79.

--disconnectBeforeFrame/-d Frame number before which to stop tracing.

{frame number}

--frameCaptures. [CaptureMode] {comma- |Frame captures for the given mode, where [CaptureMode] is one of the frame
separated list of frame numbers} capture keys. See 6.23.2.2 Frame captures reference on page 81.

--cl. [Resource] {1/0} Explicitly enable (1) or disable (O) a resource, where [Resource] is one of the CL
resource keys. See OpenCL config object keys on page 81.

--gles. [Resource] {1/0} Explicitly enable (1) or disable (0) a resource, where [Resource] is one of the
OpenGL ES resource keys. See OpenGL ES config object keys on page 81.

--vulkan. [Resource] {1/0} Explicitly enable (1) or disable (0) a resource, where [Resource] is one of the
Vulkan resource keys. See Vulkan config object keys on page 81.
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7. Known issues

This chapter describes some known issues in this release of Graphics Analyzer.

7.1 Intercepting without using LD_PRELOAD

Sometimes it might not be possible to use .o _prRELOAD, for example if L PrRELOAD is already being
used for another purpose.

In such cases, you must define both 1o 1.7BRARY PATH and MGD LTBRARY PATH as follows:

LD LIBRARY PATH=/path/to/intercept/dir/:$LD LIBRARY PATH
MGD LIBRARY PATH=/path/to/original/drivers/dir/

In this example, /path/to/intercept/dir/ is the directory on the target where the installation
files were copied to. This directory must contain 1ibinterceptor.so, and include symlinks to
libinterceptor.so named libEGL.so,libGLESvZ.so,and 1ibGLESv1 CM.so.

You can set up the required symlinks for 1ibinterceptor.so as follows:

In -s /path/to/intercept/libinterceptor.so /path/to/intercept/1ibEGL.so

Iln -s /path/to/intercept/libinterceptor.so /path/to/intercept/l1ibGLESvl CM.so
ln -s /path/to/intercept/libinterceptor.so /path/to/intercept/libGLESv2.so

In -s /path/to/intercept/libinterceptor.so /path/to/intercept/libOpenCL.so

The directory /path/to/original/drivers/dir/ should contain the pre-existing 1ibGLESv2.s0 and
1ibEGL. so files from the graphics driver installation.

1D _PRELOAD does not need to be defined when using this method.
When a graphics application runs, the Graphics Analyzer interceptor libraries are loaded from the

1D TLIBRARY PATH first. These interceptor libraries dynamically load the original graphics libraries
from the Mmep 1.1BRARY PATH lOCation, as required.

You might find that the original Mali™ drivers pointed to by MGD LIBRARY PATH

are small shim libraries that do not export any entry points, but instead depend

ON libmali.so. If so, the interceptor fails to correctly load the driver libraries
unless MGD LIBRARY PATH also contains 1ibmali.so. If this is not the case, you

can either point Mep_1.1BRARY PATH tO the location of 1ibmali.so, regardless of
whether that location also contains the libEGL or libGLES libraries, or you can point
MGD LIBRARY PATH to a location that contains symlinks to 1ibmali.so instead.
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7.2 Multiple drivers installed on the system

More than one version of the Mali™ driver might be installed on your device. For example, if you
aim to use both X11 and FBDEV on the same Linux platform.

If so, it might not be possible to use the standard n.o_prELOAD approach on its own.

Instead, you must use that approach as normal while defining the Mmep_1.1BRARY PATH environment
variable as follows:

MGD LIBRARY PATH=/path/to/original/drivers/dir/

The /path/to/original/drivers/dir/ contains the pre-existing 1ibGLESv2.so and 1ibEGL. so files
from the graphics driver installation.

When a graphics application runs, the Graphics Analyzer interceptor libraries are preloaded as
normal. The interceptor libraries then dynamically load the original graphics libraries from the
MGD LIBRARY PATH location as required.

See /.1 Intercepting without using LD_PRELOAD on page 84 for more information.

7.3 Application crashes while tracing

Graphics Analyzer uses shader replacement to instrument the application and provide debug
visualizations of captured frames. To avoid the application using previously compiled and cached
shader or program binaries, which cannot be instrumented, the installed Graphics Analyzer layer
forces all calls that load previously compiled shaders and programs to fail.

This forced failure includes functions such as glshaderBinary () O glProgramBinary (). If an
application does not handle these functions failing cleanly, falling back to a new source compilation,
the application might fail to start or might render incorrectly.

You can work around this issue by doing one of the following, depending on the application:

e Clear the application storage cache, which clears the automatic caching on Android.

o Delete all application data, which clears any application managed caching.

e Uninstall and re-install the application, forcing a fresh compile on first load.

Calls to g1ShaderBinary () Of glProgramBinary () can fail at any time on a device,
for example if a system update installs a newer graphics driver. Applications should
therefore always fall back to compiling from source when binary loads fail.
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